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1 Getting Started 

EZ-View is a SCADA (Supervisory Control and Data Acquisition) package for the EZT-560/570i and 430i 
chamber control systems, and also provides support for use with P-Series profile controls and Future Design 
Controls’ 100, 300 and C-Series single-loop PID controllers, L91/L41 limit controllers and IO modules.  Data 
from each device can be monitored from the Windows® based EZ-View package. Connection to the 
individual devices is accomplished via an RS485 serial connection or Ethernet-to-serial connection. 
  
EZ-View provides a rich set of tools for control interaction and data analysis. Control data can be viewed in 
device detail, faceplate, digital and trend formats.  You can change set points, alarm set points and even 
create, save, download and start profiles for any EZT or P-Series controller in the system. 
 
The EZ-View software package can monitor up to 128 individual devices.  Each of the 128 devices, whether 
an EZT controller, or P-Series controller for example, can have their data saved to the hard disk at user-
defined rates.  Data file analysis tools (digital and trend) make looking at profile run data a simple task. 
 
EZ-View offers 21CFR Part 11 security features for use in Pharmaceutical or any industry that requires 
controlled security access to software functions, encrypted data, electronic signatures and audit trail listings. 
 
NOTE: This manual covers the use of EZ-View.  See the EZ-View Configuration Manual for information 

regarding the setup and configuration of each individual device.  For detailed operation of the EZT-
560/570i or other control product, please see the respective controller manual. 

 
 

1.1 Hardware Requirements 

PC: minimum 2GHZ Pentium4 with 512MB of RAM. 
OS: 98, NT 2000, XP Professional, Vista and Windows 7 operating systems supported. 
 
EZ-View will run on a lesser machine but performance may suffer if large trend buffers are used.  It is 
recommended that a PC with an actual serial port be used.  However, since many computers no longer 
provide a standard serial port, USB to serial port converters can be used.  Note that port assignment for the 
converter can change depending upon which USB port it is connected to.  Therefore, once the adapter has 
been connected to the computer and the proper port number is assigned in the EZ-View Configurator, the 
adapter should always remain connected to the same USB port for use with EZ-View.  
 
Supported Controller Models: EZT-560/570i and 430i, P-Series profile controls, 100, 300, and C-Series 

single-loop PID controllers, L91/L41 limit controllers and IO-
8TCS/6RTD/8AIIS/8AIVS modules with Modbus serial communications. 

 
When using Ethernet communications, serial to Ethernet protocol converters are required.  Future Design 
Controls offers the model PC-E converter for this purpose.  One PC-E is typically required for each device in 
the system.  In addition, a Moxa MB3170, MGate Modbus master is required at the PC to address individual 
controllers from the PC’s serial port over the Ethernet network.  Each of these devices converts the serial 
communications signals between the PC and individual controllers to an Ethernet protocol format so that a 
network connection can be used. 
 
 
  

Windows® is a registered trademark of the Microsoft Corporation 
 

 



                           EZ-View 

1.2  EZ-View                        GETTING STARTED 

1.2 Connecting Controllers to EZ-View 

Connecting the individual EZT-560/570i, EZT-430i and P-Series profile controllers to EZ-View, involves 
making the proper communication wiring connections and setting the proper Modbus slave address in each 
controller that is on the communications link.  If the addresses are not set correctly, or multiple controls have 
the same communications address, the system will not work properly.  Each controller must have its own 
unique address, from 1 to 128, corresponding to the address number (Add#) in the EZ-View Configurator. 
 
NOTE: The location of the controller on the communications network does not matter when assigning the 

communications address.  The controller is identified by its address only, not its position when wired 
into the communications link. 

 
 
1.2.1 Setting the EZT-560/570i Controller Address 

To assign the communications address from the EZT main view screen, select “System Setup” from the 
Setup menu.  Next, select “Web Server/Modbus/VNC” from the Setup menu.  This will display the Web 
Server/Modbus/VNC screen. 
 

 
 
 Touch the address entry field for the “Modbus Add/Parity” settings and enter the desired address for the 
controller on the network.  The address entered here, will correspond to the address (device) number in EZ-
View.  In order to view the controller in EZ-View, the corresponding device address in EZ-View must be 
configured to match the EZT and be enabled under “Device Setup” in EZ-View. 
 
The EZT can only be assigned addresses in the range of 1-31.  When assigning controllers to EZ-View, be 
sure to leave the first 31 addresses open for EZT controllers.  If more than 31 EZT’s are going to be installed 
on the communications network, an Ethernet to serial network is required. 
 
Make sure that the parity setting of the EZT is set to the default of “Even”.  If the parity setting is not set 
correctly, EZ-View will not be able to communicate with the EZT. 
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1.2.2 Setting the EZT-430i CM Controller Address 

To assign the communications address from the main view screen, select “Settings” from the Device menu.  
Next, select “Comms” from the Comms settings menu.  This will display the Communications screen. 
 

 
 
Touch the Modbus Address entry field and enter the desired address for the controller on the network.  The 
address entered here, will correspond to the address (device) number in EZ-View.  In order to view the 
controller in EZ-View, the corresponding device address in EZ-View must be configured to match the EZT-
430i CM and be enabled under “Device Setup” in EZ-View. 
 
The EZT-430i CM can only be assigned addresses in the range of 1-31.  When assigning controllers to EZ-
View, be sure to leave the first 31 addresses open for EZT-430i CM controls.  If more than 31 controls are 
going to be installed on the communications network, EZT-430i CM controls with the same Modbus address 
must be placed on separate PC-E converters.  The Moxa, MGate Modbus master can then be configured to 
assign a controller address of 62 in EZ-View for example, to an EZT-430i CM controller with a Modbus 
address of 9 at the IP address of the PC-E converter. 
 
The address re-assignment is transparent to EZ-View, which allows a total of 128 EZT-430i CM controls to be 
attached to the network.  For additional information regarding the configuration of the MGate Modus master, 
see Section 3.0, Configuring the MGate Modbus Master of this Guide.  
 
 
1.2.3 Setting the EZT-430i LC Controller Address 

To assign the communications address from the main view screen, select “Settings” from the Device menu.  
Next, select “Comms” from the Comms settings menu.  This will display the Communications screen. 
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Touch the Modbus Address entry field and enter the desired address for the controller on the network.  The 
address entered here, will correspond to the address (device) number in EZ-View.  In order to view the 
controller in EZ-View, the corresponding device address in EZ-View must be configured to match the EZT-
430i LC and be enabled under “Device Setup” in EZ-View.  The Parity settings must also be set for “Even” in 
order to be compatible with EZ-View.  
 
The EZT-430i LC can only be assigned addresses in the range of 1-31.  When assigning controllers to EZ-
View, be sure to leave the first 31 addresses open for EZT-430i LC systems.  The EZT-430i LC can be 
assigned to other address slots in EZ-View; however, an Ethernet to serial network is required. 
 
NOTE: If more than one device is to be connected to the PC running EZ-View, a separate RS232/485 

adapter is required for each EZT-430i LC in order to convert its RS232 serial connection to an 
RS485 serial connection in order to connect multiple devices on the communications link. 

 
 
1.2.4 Setting P-Series/Single-Loop Controller Communication Parameters  

The 100, 300, L91/L41, C and P-Series controllers provide additional communications settings for baud rate, 
data bits, and stop bits in addition to the communications address and parity.  For instructions on how to 
access these settings, see the respective controller manual for the model of controller you are using.  In order 
for the controllers to communicate with EZ-View, set the communication settings to the factory default of 9600 
baud, 8 data bits, even parity and 1 stop bit as applicable. 
 
The communications address entered in the controller will correspond to the address (device) number in EZ-
View.  In order to view the controller in EZ-View, the corresponding device address in EZ-View must be 
configured to match, and be enabled under “Device Setup” in EZ-View. 
 
 
1.2.5 Setting IO Module Communication Parameters  

The IO-8TCS/6RTD/8AIIS/8AIVS modules must be configured prior to connecting them to the EZ-View 
communications link.  This includes setting the thermocouple or RTD type for temperature models, and 
programming the proper communication settings for compatibility with EZ-View. 
 
NOTE: Analog and voltage input models must be programmed for the 0-4095 input range (input type =1).  

The EZ-View Configurator provides linear scaling for each individual voltage and/or current input 
that allows the user to scale the 0(2)-10V or 0(4)-20mA signal to represent values in engineering 
units. 

 
For information regarding the steps involved in configuring the various IO modules, consult the IO Manual on 
using FDC IO Studio software, a free Windows based software package provided by Future Design Controls 
that provides a simple, easy to use interface for configuring all IO modules.  The programmed communication 
settings must be set as follows: 
 
Baud Rate:  9600 
Parity:    Even 
Stop Bit:   1 
Reply Delay:  0 
 
Once the module as been configured using IO Studio, DIP switch ten (0) must be turned on to activate the 
programmed communication settings so that the module can communicate properly with EZ-View.  DIP 
switches 1-7 must also be set to correspond with the desired address for the IO module on the EZ-View 
communications link. 
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1.2.6 RS485 Serial Communications Wiring 

When installing the RS485 serial communications link, the wiring should be run using a minimum of 24 AWG 
twisted-pair, copper conductors.  For short distances, non-shielded wiring can be used as long as proper 
separation from any power wiring, fluorescent light fixtures or other sources of electrical noise, is maintained.  
For longer distances, or in environments where a lot of electrical noise is present, shielded twisted-pair wire is 
recommended. 
 
NOTE: When using shielded twisted-pair, be sure to ground only one end of the cable.  Allowing any other 

portion of the cable shield to come in contact with ground, or grounding both ends, will cause 
ground loop currents to flow in that section of the cable shield which can disrupt communications. 

 
 

Many factors affect the performance of an RS485 communications network.  These include the total length of 
the wiring, the quality of wire used, the total number of controllers on the link and what sources of electrical 
noise are present in the environment.  An RS485 network can be run as far as 4000 feet and perform reliably; 
however, the distances you may be able to achieve in your application may be much less. 
 
Distances 1000 feet or less should present little issues, if any, with performance, regardless of the number of 
controls on the link.  When exceeding 1000 feet, performance may begin to degrade, so it is important to 
follow good installation practices and use shielded wire.  This is exceedingly important in areas where 
wireless networks or other forms of wireless communications are present.  The more exposure the RS485 
wiring has to the emissions from the transmitters of wireless devices, the more prone it will be to 
communications errors.  CSZ recommends an Ethernet to serial communications network for any installation 
where the total wiring distance can exceed 2000 feet. 
 
 
1.2.7 Ethernet to Serial Communications Wiring 

Ethernet communication provides a very robust and reliable backbone for controller communications even in 
noisy environments, and offers a virtually unlimited distance between the controllers and the PC running EZ-
View.  However, special consideration must be taken when connecting controllers to EZ-View over an 
Ethernet network via the PC-E protocol converters. 
 
To set up this type of communications link, each PC-E (typically one per controller) is configured with a 
unique IP address.  The IP address must then reference the specific Modbus address of the controller, so that 
the Moxa MB3170, MGate Modbus master can send the proper Modbus command to the correct PC-E in 
order to communicate with the controller.  In addition, the controller communications network should be 
separated from all other networks within the building. 
 
While the convenience of Ethernet makes it appear that you can simply connect any device to your network 
and make it available, doing so can cause performance issues when using EZ-View.  In order for EZ-View to 
perform operations such as data logging for example, it must be able to acquire data when needed to log it.  If 
there is heavy network traffic from other devices like printers, a co-worker downloading a large file from the 
internet, etc., this can consume most of the network bandwidth at the time EZ-View needs to acquire data.  
Since the network is consumed with other activity, EZ-View would not be able to acquire the data it needs and 
a communications error would result. 
 
To insure proper operation, EZ-View should be run and an independent Ethernet network to prevent other 
business machines from interrupting communications.  Setting up the PC to controller network, and the steps 
required to properly configure the PC-E and Moxa Ethernet to serial converters, is beyond the scope of this 
manual.  Please see Future Design Controls, EZ-View Network Communications Guide, for information on 
how to properly set up an Ethernet to serial communications network. 
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1.3 Performance Considerations 

For each device enabled in EZ-View, the software must query data from the controller in order to display the 
information and data log the values.  While communications to each individual device happens very quickly, 
as more devices are added to the communications link, the total amount of time that elapses between each 
read of a controller for data increases.  This begins to slow the rate at which real-time data can be acquired 
and displayed in EZ-View. 
 
This is not a limitation of the software, but the limitation of the communications link.  For a system with a 
single EZT-560/570i controller, EZ-View can capture and display data as often as every 1500ms.  However, if 
ten EZT-560/570i controllers were attached at the given 1500ms per control, that results in a 15 second scan 
rate.  Thus, EZ-View is only able to acquire data for each controller once every 15 seconds.  Depending on 
the desired real-time data update rate, it may be necessary to divide the total number of devices between 
multiple PC’s running EZ-View to keep the total scan time as short as possible. 
 
EZ-View's scan rate can be adjusted by the user under Device Setup.  This adjusts the polling interval, i.e., 
the minimum period between commands that EZ-View sends to read data from each device on the 
communications link.  The scan rate can be adjusted from 100ms to 5000ms (5 seconds).  The shorter the 
time period the faster EZ-View scans all enabled devices; however, communication errors may result since 
not enough time elapses between the last controller response and the next command to the EZT. 
 
 
1.3.1 Device Scan Rates 

In order to acquire data from each device on the communications link, EZ-View must send a “read” command 
to tell the device to send the requested information.  There is a limit to the amount of data that can be sent in 
each response, therefore, certain devices may require more than one read command in order to get all 
available data from the device. 
 
The total scan time for each device, i.e., the time it takes to acquire all of the data, is equal to the number of 
read commands multiplied by the scan rate set under Device Setup.  For example, an IO module requires one 
read command.  At a 500ms scan rate, it would take 500ms to acquire the data.  An EZT-560/570i controller; 
however, requires 3 read commands.   Using the 500ms scan rate, it would take 1.5 seconds to acquire the 
data for an EZT-560/570i.  The number of devices, the types of devices and the scan rate, all play a role in 
the total time it takes EZ-View to acquire data from all devices enabled in the system. 
 
The number of read commands required per device is as follows: 
 
EZT-560/570i =       3 reads 
EZT-430i CM =        3 read 
EZT-430i LC =        1 read 
P-Series Profiling Controls =   1 read 
100, 300 and C-Series Controls =  1 read 
L41/91 Limit Controls =     1 read 
IO Modules =        1 read 
 
Using the information above, it is possible to calculate the minimum amount of time that is required to obtain 
real time data updates for any combination of devices.  This flexibility allows EZ-View to be tailored for 
virtually any application from a simple data acquisition system using basic IO modules, to a combination 
central control and acquisition package by combining EZT-560/570i, limit and single loop controls and IO 
modules, to make a plant wide monitoring system. 
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1.4 Turning on Controllers in EZ-View 

To enable controllers in EZ-View, select “Device Setup” from the "Setup” menu.  The Device Setup screen 
will be shown, which allows the user to enable/disable any controller in the system.  This can be done in any 
order (controllers do not have to be enabled sequentially for the system to work properly). 
 

 
 
To turn on a controller, simply place a red “check” in the on/off status check box by clicking on it.  The 
controller number (Dev#) corresponds to the Modbus slave address of each controller on the communications 
link.  By enabling the control in the list, you enable communications with the controller having the 
corresponding Modbus address.   
 
Each controller in the list, along with its corresponding control loop values, can be individually named for easy 
identification throughout all EZ-View display screens and data log files as with the EZ-View Configurator.   To 
edit a tagname, double click the item you wish to change in the grid and enter the desired name.  Up to 20 
characters can be used for each tag with the exception of a period “.”, a forward slash “/” or backslash “\” and 
a comma “,”.  EZ-View automatically prohibits the use of these characters so no effort is required on the part 
of the operator. 
 
NOTE: If you leave a tagname blank, it will not be included in the tag database for saving data, trending or 

display on any of the EZ-View screens.  Changes made to any of the device tagnames will also take 
affect in the EZ-View Configurator. 

 
 
1.4.1 Communications Settings 

The scan rate of EZ-View can be adjusted to change the rate at which each controller in the system is 
scanned.  The lower the time setting, the faster data is gathered from each controller.  The field can be 
adjusted from 100ms to 5000ms (5 seconds).  For the best performance, adjust the scan time to the lowest 
possible value.  If frequent communications errors occur at faster scan rates, try increasing the time 
incrementally until the errors are reduced or eliminated.  When EZT controllers are used, the default setting of 
500ms is recommended. 
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The "Enable beep on comms error" allows an operator to select if the computer generated "beep" should 
occur during a communications error with a controller.  This provides an audible alert to an operator each time 
a communication error occurs to draw their attention and correct the problem.  Regardless of this selection, 
the EZ-View Logger will record and store all data related to communication errors, so an operator can be 
alerted to the problem when they are available. 
 
 
1.4.2 System Alarm Settings 

The "Enable alarm logging" checkbox allows an operator to enable or disable the alarm logging feature.  Real 
time alarms will still be printed to the system alarm log, but disk based historical recording of alarms will be 
turned off if this feature is disabled.  If enabled, the alarm log will be written each time an alarm occurs or 
when a user deletes, acknowledges or clears an alarm.  A new alarm log is created for each day. 
 
The "Enable single beep on new alarm" checkbox allows an operator to enable a single computer beep when 
a new controller alarm is activated. 
 
The "Beep until any alarm is acknowledged" checkbox allows an operator to enable a continuous computer 
beep on a new alarm, until the alarm is silenced using the "silence alarm" icon located on the toolbar of the 
System Alarm Log window. 
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2 Monitoring and Controlling Devices 

EZ-View provides the user with Windows® style drop down menus that provide quick access to all data views 
and options. The multi document interface allows the user to place more than one data view (including trends, 
digital values and thumbnails) on the screen for monitoring real time operation of multiple devices at once. 
 

 
 
File Menu 
The “File” menu provides access to the Load Project and Save Project options as well as the option to Exit 
the EZ-View program. 
 

View Menu 
The “View” menu provides navigation to all standard view screens.  These include the EZT-430i-CM Detail 
View, EZT-560/570 Detail View, P-Series Profiler, EZT-430i-LC Detail View, Single Loop tuning, Digital 
Values, Alarm Log, Real Time Trends, Logging Overview, Data File Viewer and Audit Trail Viewer. 
 
Thumbnails Menu 
The “Thumbnails” menu provides access to the individual controller thumbnail views.  The thumbnail views 
provide basic operational data of all controllers connected to the system in groups of four at a time. 
 
Setup Menu 
The “Setup” menu provides access to all configuration options of EZ-View.  These include Device Setup, 
System Security, System Data Logging, Software Device Alarms and Relay Card, Email Client and Web 
Server Settings.   
 
Users Menu 
The “Users” menu provides access for user log on and log off when security is enabled, and also allows the 
Current User of the system to be viewed    The Change Password selection allows the current user to enter a 
different password for their secure log on while the System Operator Message selection allows the user to 
add a message to the system data logging file if enabled. 
 
Mode Menu 
The “Mode” menu allows the user to switch the EZ-View mode of operation between simulation and real time.  
When in simulation mode, all controller values are simulated by the software.  When in real time mode, EZ-
View gathers all data from the individual controllers over the communications link. 
 
Window Menu 
The “Window” menu allows the user select from all enabled view screens and bring the desired view to the 
front.  It also provides the ability to sort the current views and automatically arrange them in a cascaded view 
or tile them in horizontal or vertical fashion. 
 
Help Menu 
The ‘Help’ menu provides access to the current EZ-View program version and system information. 
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2.1 EZ-View Projects 

The EZ-View project options are accessed from the File menu.  This is a powerful feature that allows users to 
store all device setup data, logging setup data, tagnames, security access and trend setups to a “Project”.  
Any number of projects can be saved to the hard disk, and then loaded at a later date. 
 
This provides the ability to store different EZ-View configurations based on specific operations.  By simply 
loading a project, all device setup, trend setup and logging setups will be loaded according to the project.  It 
also provides the ability to create a “back-up” of EZ-View’s configuration, so that in the event of a computer 
failure or upgrade, the project can be loaded to a fresh install of EZ-View, and the system is up and running 
with no further setup required.  
 
To save all current configuration settings for EZ-View, select “Save Project” from the File menu.  EZ-View will 
display the standard “save as” project window and will default to the Projects directory.  The user has the 
ability to navigate to a different directory to save the project as well as enter a name for the project.  Once the 
desired location and name have been entered, click the “Save” button.  EZ-View will then create a project 
folder with the given name and store all configuration files to the project folder.  
 

 
 
To load a project, select “Load project” from the File menu.  EZ-View will display the standard “browse” folder 
window, and will default to the Projects directory.  The user can also navigate to different directories in order 
to select a desired project folder.  Once the desired project folder is located, click on the folder name to select 
it and click on the “OK” button to load the project.  EZ-View will then update all device settings, tagnames, 
trend setups, security access rights and users as well as logging settings to the project settings.   
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2.2 EZT-430i-CM Detail View 

The “EZT-430i-CM Detail View” is accessed from the View menu.  It is a multi-tab interface which is divided 
into three sections.  It provides direct access to all control parameters of each individual EZT-430i CM 
attached to the system.  Available controllers are selected from the drop down menu at the top of the screen 
and are listed by device name as assigned on the Device Setup screen for easy identification. 
 
 
2.2.1 Detail View 

The “Detail” view tab provides the user with all current EZT-430i CM “run” data.  This includes all control loop 
process values as well as the current setpoints and percentage of output.  The System Events status 
indicators provide the user with immediate feedback of the current event status.  The current schedule name, 
status and events active are also shown at the lower left of the screen. 
 

 
 
The main digital display window allows the user to select and control each loop of the EZT-430i CM.  The 
selected loop will have its tagname shown in the top left of the window.  To select other control loops, simply 
click on one of the tagnames associated with the desired loop in the Device Detail/Point Select list box on the 
right of the screen. 
 
To change the loop’s setpoint, click on the current setpoint and enter the desired value.  EZ-View 
automatically keeps track of each loop’s min/max setpoint limits as entered in the configurator, so if the user 
enters a value that exceeds the minimum or maximum allowed setpoint, the value will be coerced to the 
corresponding limit value. 
 
When running the system in manual mode, the control loop setpoints as well as all system events can be 
accessed and operated by the user.  When running in automatic schedule mode, the setpoints and events 
can be modified only after the schedule is put into hold.  These changes will not affect the saved schedule, 
only the current stage of the schedule that is running.  The Schedule Control, Run, Hold and Stop buttons 
allow the operator to run the currently loaded schedule from the PC.   If a schedule is not loaded into the 
controller, pressing the “Run” button will not start a schedule. 
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When a running schedule is placed in hold, the operator has the ability to advance forward or backward in the 
schedule.  This is done by pressing the advance “backward” or “forward” buttons.  These buttons appear to 
the left and right of the “hold” button when a schedule is in hold.  As the user advances through each stage, 
the stage number and time remaining in the stage will update to indicate the current stage selected. 
 

       
 
The “Auto Tune” and “Auto/Manual” buttons allow the user to place the selected control loop of the EZT-430i 
CM in auto tune and switch the loop between automatic and manual output control.  When auto tune or 
manual output control is active, the respective control button will be highlighted green.   When the loop is 
placed in manual output control, clicking on the percentage of output display field will allow the user to enter a 
manual output percentage for the loop.   
 
The “Data Logging” button provides access to the control’s individual data logging settings.  This allows the 
user to start/stop individual logging of the EZT-430i CM and also choose what parameters are to be logged.  
When logging is active, the button will be highlighted green to provide visual feedback to the user indicating 
the logging status.  See Section 4.0 Data Logging, for more information on the EZ-View data logging features.  
 
The “General Notes” and “Service Notes” buttons provide access to the respective notes entry for the 
controller.  See Section 3.0 Control Notes, for more information on using the EZ-View notes feature.  
 
 
2.2.2 Schedules 

The “Schedules” tab provides access to the schedule editor and allows the user to open, create, edit and 
save schedules from the PC interface.  It also provides the user with the ability to download and upload 
schedules to and from the selected EZT-430i CM controller.   
 
Schedules can be created or edited at any time during operation; however, schedules can only be 
downloaded when the control is not currently running a schedule.  All schedules are saved directly to the hard 
drive of the PC which makes them available for download to any EZT-430i CM in the system, not just the one 
currently selected for operation. 
 
CAUTION: It is recommended that schedules be created and named for use with specific EZT-430i CM 

controllers in the system and not shared between multiple controllers.  While EZ-View allows you 
to share schedules among multiple EZT-430i CM controls, unless each controller is configured 
identically with the same loops, decimal point scaling, events, etc., the schedule for one control 
may not operate correctly on another if they are not configured the same.  While the EZT-430i 
CM will only operate within its configured limits, product damage may occur if the schedule does 
not operate as expected. 

 
 
 

Stage Advance Buttons 
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The schedule entry form provides stage entry fields for time in hours, minutes and seconds, jump count, jump 
stage and control loop setpoints for each loop configured on the control as shown below. 
 

 
 
To enter stage data, simply click on the cell in the “spreadsheet” and enter the desired value.  EZ-View will 
limit entries to valid data ranges for time and prevent the user from entering setpoints that exceed the limits 
set for the control loop in the EZ-View Configurator.  Upon pressing the “Enter” key on the PC keyboard to 
enter a value in the cell, EZ-View will automatically jump to the next cell in the row to speed the entry process.  
Keypad usage (left/right/up/down and entering a number) is also supported for fast entry.  
 
The toolbar icons for schedule editing are as follows (order from left to right): 
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2.2.2.1 Setting Schedule Guaranteed Soak Setpoints 
 
The guaranteed soak settings for the schedule are accessed by pressing the “GUAR SOAK” button.  When 
pressed, the Guaranteed Soak Setpoints window is displayed. 
 

 
 

The Guaranteed Soak option allows the user to set a control tolerance band for each control loops.  The 
value entered for guaranteed soak is an "even sided" band above and below the current schedule setpoint for 
each control loop.  If during a schedule run, a control loop from its current setpoint by more than the specified 
band value, the schedule will hold until the process falls back within the band.  
 
The guaranteed soak values are "global" and apply to all schedule stages.  The operation for guaranteed 
soak can be enabled or disabled for each control loop independently on a "per stage" basis by selecting or 
de-selecting the soak event when configuring each stage. 
 
 
2.2.2.2 Setting Auto Start 
 
The "LOOPS ACTIVE/AUTO START" button provides access to the schedule auto start settings.  This is a 
feature that can be used to start a schedule on a specified date or day and time (of a 24-hour-clock). 
 

 
 

To program an auto start for a schedule, enter the desired date or day of the week and time that you want the 
schedule to start on, and turn on auto start by selecting “AutoStart By Date” or “AutoStart By Day”.  When the 
schedule is then downloaded to the controller and started, the schedule will enter “auto start. 
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The schedule will stay in auto start and automatically begin operation at the specified date and time or day of 
the week and time specified. 
 
NOTE: The time is entered in a 24 hour format.  To convert time from a 12 hour format (AM/PM) into 24 

hour format, add 12 to the hours for PM time.  For example, 2pm will be a value of 14 (2 + 12) for 
hours.  A time of 5:30pm will be 17 hours, 30 minutes. 

 
 
2.2.2.3 Setting Wait For Events 
 
The stage “wait for” options are accessed by pressing the “WAIT FOR EVENTS” button.  When pressed, the 
stage wait for options screen will be shown.  The loop and monitor tab selections allow the user to select 
which loops and/or monitors (if any) will be used as a wait for condition.  The loop and monitor selections 
share a common wait for setpoint (Wait SP).  This setting is used to set the trigger point for the wait for 
condition, i.e., the value that the loop or monitor must meet for the profile to continue. 
 

     
 
NOTE: The setpoint entry for a 'wait for' loop or monitor is critical in order for the step to operate correctly.  

During the wait state, the selected loop or monitor input must arrive at or cross the setpoint in order 
for the profile to resume operation. 

 
 
The digital input selections are made from the 'Digital' tab on the wait for events screen.  When using the 
digital input wait for selection, the digital input must be configured as a 'wait for event' input on the EZT-430i 
CM.  If it is not configured as a 'wait for event' input, the schedule will ignore that input when the wait for stage 
is executed and continue through the stage as normal. 
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2.2.2.4 Schedule Notes 
 
The schedule notes feature of EZ-View is accessed by pressing the “SCHED NOTES” button.  When 
pressed, the schedule notes entry window will be shown.  
 

 
 

Notes can be entered with up to 255 characters each.  When a new note is created, it is automatically tagged 
by date and time of creation.  Double-click in the note text field to enter text for the note.  Notes will be 
displayed in ascending order, i.e., the latest entry is shown at the top and the oldest entry will be at the 
bottom of the list.  The toolbar icons for schedule note entry are as follows (order from left to right): 
 

 
 
When finished entering notes, press the "Close" button to return to the main schedule editing screen.   
 
IMPORTANT:  The schedule notes are saved with the schedule.  After entering a new note or editing 

existing schedule notes, you must save the schedule to keep the changes.  If you select 
or create a different schedule prior to saving the current schedule, all updates to the 
schedule notes will be lost. 

 
 
2.2.3 Setup 

The “Setup” tab provides access to the EZT-430i CM alarm settings, I/O monitor and schedule power 
recovery options.  The number of alarms accessible, and I/O shown on the monitor screen, are dependant 
upon the number programmed for the control in the EZ-View Configurator.   
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2.2.3.1 Alarm Settings 
 
The “Alarm Settings” tab provides access to the selected EZT430i CM alarm module which consists of up to 
30 user configurable alarms. 
 

 
 
NOTE: If changes are made to any of the following alarm settings, you MUST press the “Save Alarm 

Settings”’ button at the lower right of the screen in order to save the changes to the alarm.  If you do 
not press the button prior to leaving the screen or going to the next alarm, all changes will be lost 
and the alarm will maintain its previous configuration. 

 
 
The Alarm Number in the upper left of the display, shows the current alarm being configured.  To change the 
alarm number, click on the current alarm number and enter a different number.  If the alarm number entered 
exceeds the maximum number of alarms available, the number will be coerced to the last available alarm. 
 
The Input selection is used to select the loop or monitor input that will be used for the current alarm number.  
The same loop or monitor input can be used more than once, on any alarm. 
 
The Alarm Type selection is used to set the type of alarm.  When set to “No Alarm”, the alarm is disabled.  
Available alarm type selections are as follows:  
 
Process: A process alarm uses one or two absolute set points to define an alarm condition.  

A process alarm can be set for high only, low only or both high and low. 
 
Deviation: A deviation alarm uses one or two set points that are defined relative to the control 

set point.  High and low alarm set points are calculated by adding and/or 
subtracting offset values from the control set point.  If the set point changes, the 
window defined by the alarm set points automatically changes with it.  A deviation 
alarm can be set for high only, low only or both high and low. 
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NOTE: The deviation alarm type is not available for the monitor inputs.  The 
monitor inputs are not associated with a control set point 

 
 

Percent Output (%Out): A percent output alarm uses one or two absolute set points to define the alarm 
condition.  The alarm can be set for high only, low only or both high and low. 

 
NOTE:  The percent output alarm type is not available for the monitor inputs.  

Monitor inputs do not have control outputs.  
 
 
Rate of Change (ROC): A rate of change alarm looks for an amount of change in the input over a pre-

determined period of time.  It uses a single ‘delta’ set point to define the amount of 
change allowed and a single time set point to define a time period in which the 
amount of change is allowed to occur.  A rate of change alarm can be set for high 
only (alarm on rise), low only (alarm on fall) or both. 

 
 
The Alarm Mode Selections are used to select the alarm action.  Available selections are as follows:  
 
Self Clear/Latching: A latched alarm will remain active after the alarm condition has passed unless 

acknowledged by the user.  Latched alarms are acknowledged by the user in 
pressing the ‘Silence’ button on the Alarm Monitor screen or by activating a digital 
input configured for ‘Remote Alarm Silence’.  An alarm that is not latched (self-
clearing) will deactivate automatically when the alarm condition has passed. 

 
NOTE: Latching alarms are acknowledged even when the alarm condition is still 

present when the user activates the alarm silence.  The latched alarm will 
then automatically clear once the alarm condition is no longer present.  If the 
alarm silence was not activated during the alarm period, the alarm will 
remain latched until the user activates the alarm silence. 

 
 
Silent On/Off: This is used to control the method by which an alarm is reported.  When ‘Silent Off’ is 

selected, an alarm condition will trigger the system/audible alarm digital output (if 
configured in the system) and the screen background will turn red to indicate the 
alarm condition.  The audible alert must then be manually silenced by pressing the 
silence button on the alarm monitor screen. 
 
If ‘Silent On’ is selected, there will be no audible signal when an alarm condition is 
present.  If the alarm is set to ‘self clear’, the screen background will not turn red and 
the alarm will not be reported on the alarm screen.  If the alarm is set to latching, the 
alarm will be reported in order to notify the user to acknowledge the alarm.  
 
 

Inhibit On/Off: When ‘inhibit off’ is selected, the alarm will activate immediately when the input 
exceeds the alarm set points as programmed.  When ‘inhibit on’ is selected, the input 
must first enter the normal operating range (be above the low alarm set point and/or 
below the high alarm set point) before the alarm can be activated.  Upon the next 
excursion beyond the alarm set points, the alarm will then activate. 

 The alarm inhibit feature is typically used on processes that, when in the off state, 
are in an alarm condition.  This allows the process to be started prior to the alarm(s) 
being activated and shutting down the process. 

 
 



EZ-View                         

 

MONITORING AND CONTROLLING DEVICE OPERATIONS                   EZ-View 2.11 

The Output Assignment can be used to assign one of the EZT-430i CM digital outputs to the alarm.  When 
the alarm activates, the output will work in conjunction with the alarm based on the ‘close on alarm’ or ‘open 
on alarm’ mode. 
 
NOTE: The digital output must be configured as a process alarm output.  If the digital output selected is not 

configured to be a process alarm output, it will not function according to the alarm settings.  See the 
section on offline setup of Digital Outputs in the EZT-430i CM User Manual, for information on how 
to configure the digital outputs. 

 
 
2.2.3.2 IO Monitor 

 
The “IO Monitor” tab allows the operator to view the current input and output status of the EZT-430i CM.  The 
tagnames shown for each input and output are the names assigned in the EZ-View Configurator and/or under 
Device Setup.  
 

 
 
The left column displays the digital input status while the right column lists the digital output status.  If the 
“LED” next to the input or output description is bright green, the input is on or the output is energized.  If the 
“LED” is not bright green, the input is off or the output is de-energized. 
 
 
2.2.3.3 Schedule Options 
 
The “Schedule Options” tab allows the user to set the startup state of the system in the event of a power 
failure when a schedule was running at the time power was lost.  When power is restored, the EZT-430i CM 
compares the amount of time it was off to the ‘Power Out Time’ setting and takes whatever action is selected 
in the “Profile Continue Power Out Time In Seconds”. 
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To set the power recovery action, click on the recovery mode button for the desired setting to set it as the 
power-up state.  The selected mode button will turn green to indicate that it is now the current power recovery 
mode.  The selections are exclusive to one another, i.e., only one can be selected at a time.  As a new 
selection is made, the previous setting will be automatically turned off.   
 

 
 
Select OFF to have the EZT-430i CM default to the off state on power-up.  If a profile was running when 
power was lost, the profile will be stopped.  In addition, all system events will be turned off.  Note that loop 
controls will continue with the profile’s last set point value prior to power loss with loop control outputs active 
(ON).  
 
Select HOLD to have the EZT-430i CM return to operation at the same point it was prior to the power outage.  
If a profile was running, the profile will still be active; however, it will remain in hold with the active set points 
and events that it was operating prior to losing power until manually set to continue. 
 
Select CONTINUE to have the EZT-430i CM pick-up where it left off on loss of power.  If a profile was running 
prior to the power outage, it will resume where it left off and continue through the rest of the profile.   
 
Select RESTART to automatically restart the profile that was running at power failure.  Use this option if it is 
critical for a profile to run from start to finish without interruption. 
 
Select RESUME to have the EZT-430i CM pick-up where it would be at the current time, if power had not 
been lost.  If a profile was running prior to the power outage, the EZT-430i CM will advance forward through 
the profile to the point where it would be, at the current time, and resume operation from that point. 
 
NOTE: When a schedule is NOT running and a power down/up sequence occurs, the EZT-430i CM will 

return with the same set points and system events active as when the power was lost.  If a schedule 
stays in hold regardless of power recovery configuration, refer to the CSZ configuration of the EZT-
430i CM.  Digital inputs may be used to place a schedule in hold.  This input may have to be reset 
to allow the schedule to continue. 
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2.3 EZT-560/570 Detail View 

The “EZT-560/570 Detail View” is accessed from the View menu.  It is a multi-tab interface which is divided 
into four sections.  It provides direct access to all control parameters of each individual EZT-560/570i 
attached to the system.  Available EZT controllers are selected from the drop down menu at the top of the 
screen and are listed by device name as assigned on the Device Setup screen for easy identification. 
 
 
2.3.1 Detail View 

The “Detail” view tab provides the user with all current EZT “run” data.  This includes all control loop process 
values as well as the current setpoints.  The Chamber and Customer Events status indicators provide the 
user with immediate feedback of the current event status.  The current profile name and status are also listed 
at the top of the screen. 
 

 
 
To change a loop’s setpoint, click on the current setpoint and enter the desired value.  EZ-View automatically 
keeps track of each loop’s min/max setpoint limits as entered in the configurator, so if the user enters a value 
that exceeds the minimum or maximum allowed setpoint, the value will be coerced to the corresponding limit 
value. 
 
When running the system in manual mode, the control loop setpoints as well as all system events can be 
accessed and operated by the user.  When running in automatic profile mode, the setpoints and events can 
be modified only after the profile is put into hold.  These changes will not affect the saved profile, only the 
current step of the profile that is running.  The Profile Control Run, Hold and Stop buttons allow the operator 
to run the currently loaded profile from the PC.   If a profile is not loaded into the controller, pressing the “Run” 
button will not start a profile. 
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When a running profile is placed in hold, the operator has the ability to advance forward or backward in the 
profile.  This is done by pressing the advance “backward” or “forward” buttons.  These buttons appear to the 
left and right of the “hold” button when a profile is in hold. 
 

 
 
 
2.3.2 Profile Entry 

The “Profile Entry” tab provides access to the profile editor and allows the user to open, create, edit and save 
profiles from the PC interface.  It also provides the user with the ability to download profiles to the selected 
EZT-560/570i controller.  Profiles can be created or edited at any time during operation; however, profiles can 
only be downloaded when the EZT is not currently running a profile.  All profiles are saved directly to the hard 
drive of the PC which makes them available for download to any EZT controller in the system, not just the one 
currently selected for operation. 
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CAUTION: It is recommended that profiles be created and named for use with specific EZT controllers in the 
system and not shared between multiple EZT controllers.  While EZ-View allows you to share 
profiles among multiple EZT-560/570i controls, unless each EZT is configured identically with 
the same loops, setpoint ranges, events, etc., the profile for one EZT may not operate correctly 
in another EZT if they are not configured the same.  While the EZT will only operate within its 
configured limits, product damage may occur if the profile does not operate as expected. 

 
 
To enter step data, select the desired step by clicking anywhere on its row in the "spreadsheet" or use the left 
or right buttons to change the "Current Step" number.  Enter the desired Step Time, Jump Step number, 
Jump Counts and setpoints for each loop as needed in the appropriate entry fields.  As entries are made, the 
spreadsheet will automatically update with the new values. 
 
The toolbar icons for profile editing are as follows (order from left to right): 
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2.3.2.1 Setting Auto Start/GS Soak Limits 
 
The auto start and guaranteed soak settings for the profile are accessed by pressing the "Auto Start GS Soak 
Limits" button.  When pressed, the Auto Start / Guaranteed Soak Limits window is displayed. 
 

 
 
To program an auto start for a profile, enter the desired date or day of the week and time that you want the 
profile to start on, and turn on auto start by selecting "AutoStart By Date" or "AutoStart By Day".  When the 
profile is then downloaded to the EZT and started, the profile will enter "auto start".  The profile will stay in 
auto start and automatically begin operation at the specified date and time or day of the week and time 
specified. 
  
NOTE: The time is entered in a 24 hour format.  To convert time from a 12 hour format (AM/PM) into 24 hour 

format, add 12 to the hours for PM time.  For example, 2pm will be a value of 14 (2 + 12) for hours.  A 
time of 5:30pm will be 17 hours, 30 minutes. 

 
The Guaranteed Soak Limits allows the user to set a control tolerance band for each control loop.  The value 
entered for guaranteed soak is an "even sided" band above and below the current profile setpoint for each 
control loop.  If during a profile run, a control loop deviates from its current setpoint by more than the specified 
band value, the profile will hold until the process falls back within the band.  The guaranteed soak limits are 
"global" and apply to all profile steps.  The operation for guaranteed soak can be enabled or disabled for each 
control loop independently on a "per step" basis by checking or un-checking the "GS" checkbox when 
configuring each step. 
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2.3.2.2 Setting Step Events\Wait For Input 
 
The step events and "wait for" options are accessed by pressing the "Step Events\Wait For Input" button.  
When pressed, the Step Options\Wait For Input screen will be shown. 
 

 
 
To turn on an event during the step, place a check in the checkbox next to the event description.  Note that 
the main chamber event must be on in order for the chamber to run.  Even though the a profile may be 
running, the chamber will not run unless its events are turned on.  Not all events may be available for your 
particular EZT controller.  Individual events can be enabled and disabled through the EZ-View Configurator 
which allows the selections to be tailored to your chamber and eliminate operator confusion by disabling 
items that are not available. 
  
The Wait For Loop Input and Wait For Monitor Input selections, allow the user to select which loop or monitor 
(if any) will be used as a wait for condition.  The loop and monitor selections share a common Wait For 
Setpoint setting.  This setting is used to set the trigger point for the wait for condition, i.e., the value that the 
loop or monitor must meet for the profile to continue. 
 
NOTE: The setpoint entry for a 'wait for' loop or monitor is critical in order for the step to operate correctly.  

During the wait state, the selected loop or monitor input must arrive at or cross the setpoint in order 
for the profile to resume operation.  
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2.3.3 Profile Run 

The “Profile Run” tab provides the operator with all data related to the current profile that is running in the 
EZT-560/570i controller.  All data is “view only” and updates dynamically based on the programming for the 
current step running in the profile. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



EZ-View                         

 

MONITORING AND CONTROLLING DEVICE OPERATIONS                   EZ-View 2.19 

2.3.4 Monitor Probes 

The “Monitor Probes” tab can display all additional monitor points available on the EZT-560/570i controller.  
The display screen will only the show monitor points configured in the EZT Configurator. 
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2.4 P-Series Profiler 

The P-Series Profiler is accessed from the View menu.  It provides access to the profile editor and profile 
control screens for all P-Series controllers attached to the system.  The “Profile Entry” tab allows the user to 
open, create, edit and save profiles from the PC interface.  It also provides the user with the ability to 
download profiles to the selected P-Series controller.  The “Profile Run” tab allows the user to start, stop and 
hold the downloaded profile in the selected P-Series controller.   
 
 
2.4.1 Profile Entry 

Profiles can be created or edited at any time during operation; however, profiles can only be downloaded 
when the selected P-Series controller is not currently running a profile.  All profiles are saved directly to the 
hard drive of the PC which makes them available for download to any P-Series control in the system, not just 
the one currently selected. 
 
CAUTION: It is recommended that profiles be created and named for use with specific P-Series controllers 

in the system and not shared between multiple P-Series controllers.  While EZ-View allows you 
to share profiles among multiple P-Series controls, unless each P-Series is configured identically 
with the same input range, decimal point scaling, events, etc., the profile for one P-Series may 
not operate correctly in another if they are not configured the same. 

 
 The profiles do not store configuration information for the P-Series, only the sequence of stages 

that are to be performed.  If an attempt is made to download a profile that has setpoint limits 
outside the range of the P-Series control, a download error will occur.  This could result in partial 
profile download, and running it could cause erratic operation. 

 
 
The P-Series Profiler is designed to use profile 9 of the P-Series control only.  This profile is one of the 
longest available profiles in the control, and allows for the entry of up to 64 stages.  Each individual P-Series 
control available in the system can be selected from the drop down list at the top right of the screen.  This 
allows the user to select the control to download the profile to. 
 
To enter a profile, first enter the number of stages for the profile you intend to program.  This number can be 
changed at any time during the profile entry process.  The total stages entered will then appear in the 
“spreadsheet”.  Note that the last stage of the profile must be an “End” type step.  If the profile requires 10 
stages of ramps and dwells, the total stages will have to be 11 so that the last stage can be entered as an 
“end” stage. 
 
Prior to entering individual stage data, the ramp and dwell units should be set according to the requirements 
for the profile.  The units selected apply to all stages of the profile.  These units can be changed any time 
during profile entry; however, switching ramp units between time and rate will clear the “Ramp Time” entries 
for each stage of the profile, which will require the user to re-enter all of the stage data. 
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The toolbar icons for profile editing are as follows (order from left to right): 
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2.4.1.1 Global Profile Settings 
 
These settings apply to the entire profile.  The number of stages, HoldBack band, Start SP, ramp units and 
dwell units can be changed at any time during profile entry.  However, the ramp units should be set prior to 
entering any stage data.  Ramp units can be switched between hours/minutes and minutes/seconds without 
affecting the profile, but changing the ramp units between units of time and rate, will clear all “ramp time” 
stage entries and require the user to re-enter all of the data. 
 
The HoldBack band is also known as a guaranteed soak value.  If holdback is enabled on a profile stage, this 
value will be used as the maximum allowed deviation from setpoint.  If the temperature were to deviate from 
setpoint by more than this value for example, the profile would hold until the temperature falls back within the 
band.  The default value is 1.  If you intend to use “guaranteed soak” in your profile, set this to the desired 
value; otherwise, leave it at the default value. 
 
The Start SP is the setpoint that the controller will be set to immediately upon profile start.  It eliminates the 
need for an initialization step in the profile.  In order for the profile to use the starting setpoint of the profile; 
however, the P-Series must be configured to do so.  The controller can also be set to use the current PV 
value as the starting setpoint or to use the current setpoint of the control when the profile is started. 
 
This is not something that is set with the profile.  It is a controller configuration value that determines what 
setpoint the P-Series is to use when you start a profile.  Once it is set for the desired action, it does not have 
to be set or changed again, and the controller will use the selected setpoint for each profile when it is started. 
 
The Ramp Units define the units used by the P-Series to ramp the setpoint in ramp stages.  The ramp units 
can be set for units of time in hours and minutes or minutes and seconds.  The units can also be set for ramp 
rate rather than time, i.e., ramp in degrees per hour or degrees per minute. 
 
Note that the setting here will be used for each ramp stage of the profile.  If hours and minutes are selected 
(maximum of 59 hours 99 minutes), all ramp time entries will be in hours and minutes.  If minutes and 
seconds are selected (maximum of 59 minutes 99 seconds), all ramp step time entries will be in minutes and 
seconds.  If a ramp rate setting is selected, all ramp stage will have the ramp stage entry made in either 
degrees per hour or degrees per minute. 
 
The Dwell Units define the units of time used by the P-Series in dwell stages.  The dwell units can be set for 
units of time in hours and minutes or minutes and seconds.  Note that the setting here will be used for each 
dwell stage of the profile.  If hours and minutes are selected (maximum of 99 hours 59 minutes), all dwell time 
entries will be in hours and minutes.  If minutes and seconds are selected (maximum of 99 minutes 59 
seconds), all dwell stage time entries will be in minutes and seconds. 
 
 
2.4.1.2 Stage#/Events 
 
The Stage# indicates the current stage active for event editing.  By clicking on a row in the spreadsheet, it 
sets that stage as the active stage. 
 
The Events selections for the stage are made by simply placing a check in the checkbox next to the desired 
event or PID2 selection.  As different stages are selected for edit, these fields will automatically update to 
display the selections for the current stage.  
 
NOTE: Consult the documentation provided with your chamber regarding any events configured in your P-

Series controller.  These selections allow you to turn event outputs (if equipped) on and off for each 
stage, as well as select another set of PID parameters that may be fine tuned based on a particular 
operating condition. 
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2.4.1.3 Entering Profile (Stage) Data 
 
To enter stage data, simply click on the cell in the “spreadsheet” and enter the desired value.  EZ-View will 
limit entries to valid data ranges for time and prevent the user from entering setpoints that exceed the limits 
set for the control loop in the EZ-View Configurator.  Keypad usage (left/right/up/down and entering a 
number) is the same as clicking for fast entry.  
 
The Stage Type defines the type of stage.  Available selections are Ramp, Dwell, Jump and End types.  Note 
that the last stage of the profile must be configured as an End type.  
 
The “Loop” SP entry is required for ramp and end stage types.  For ramp stages, this setpoint is used as the 
target setpoint for the stage, i.e., the setpoint the controller will ramp to by the end of the stage.  For the end 
stage, this setpoint is used by the controller once the profile ends. 
 
The controller can also be set to use the current SP value when the profile ends or to turn all outputs off and 
cease control.  This is not something that is set with the profile.  It is a controller configuration value that 
determines what action the P-Series is to take upon completion of the profile.  Once it is set for the desired 
action, it does not have to be set or changed again, and the controller will use the selected action for each 
profile when it ends. 
 
For a dwell stage, the value in this field is automatically set to the previous stage setpoint (i.e., the ramp stage 
setpoint).  For jump stages, the setpoint is automatically defaulted to the low setpoint limit for the loop as set 
in the Configurator.  This insures that the setpoint will be within the setpoint limits of the controller for proper 
download to the P-Series.  Even though the setpoint is not used on a jump stage, it must be within proper 
limits to download correctly to the profiler. 
 
The Ramp Time entry is required for ramp stage types.  The value entered here will be in units of time or 
rate.  When hours/minutes or minutes/seconds are selected for the ramp entry, the value will be entered as a 
decimal number.  The number preceding the decimal point is the first unit of time (hours or minutes) and the 
number following the decimal point is the second unit of time (minutes or seconds).  If the units selected are 
hours/minutes, an entry of 1.30 for example, is equivalent to 1 hour, 30 minutes. 
 
If ramp rate is selected, the entry will be a whole number representing the change in setpoint per units of time 
in hours or minutes.  For example, if units/minute is selected, an entry of 50 is equivalent to a ramp rate of 50 
degrees per minute. 
 
The Dwell Time entry is required for dwell stage types.  The value entered here will be in units of time as 
hours/minutes or minutes/seconds as selected for the dwell units.  The value will be entered as a decimal 
number.  The number preceding the decimal point is the first unit of time (hours or minutes) and the number 
following the decimal point is the second unit of time (minutes or seconds).  If the units selected are 
minutes/seconds, an entry of 30.00 for example, is equivalent to 30 minutes (00 seconds). 
 
The HoldBack type sets the type of guaranteed soak.  This can be entered for ramp or dwell steps.  Note that 
when entering a holdback on a ramp step, the ramp rate can be affected because the profile will hold if the 
process deviates too far from the setpoint.  There are three options for the HoldBack type. 
 
Dev Low: When deviation low is selected, the profile will hold only when the process value falls below the 

soak band [process value < (control setpoint – holdback band)]. 
 
Dev Hi: When deviation high is selected, the profile will hold only when the process value rises above 

the soak band [process value > (control setpoint + holdback band)]. 
 
Band: When band is selected, the profile will hold when the process value rises above or falls below 

the soak band [(setpoint + holdback band) < process value < (setpoint – holdback band)]. 
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The Jump Step number entry is required for jump step types.  This is the stage that the profile will jump when 
the jump is executed.  Note that the “End” step type can also perform a jump.  This allows you to repeat the 
profile without having to enter a jump step.  Thus, jump steps are only required if you need to repeat sections 
of the profile.  If you want to repeat an entire profile, just set the jump cycles in the end step. 
 
The Jump Cycles entry is required for jump and end stage types.  This is the number of jump cycles to 
perform.  The number of cycles can be set from 1 to 9999.  The value can also be set to 10000 for an infinite 
number of cycles.  If set on the “end” stage of a profile for example, this would cause the profile to run and 
repeat indefinitely until stopped by the user.  Note that a setting of 1 means that no jump is made.  The first 
cycle is completed upon reaching the jump or end step.  Thus, a setting of 1 means do the profile once, so if 
you want the profile to perform 10 cycles, you would set this value to 10.   
 
 
2.4.2 Profile Notes 

Profile notes are accessed from the “Profile Notes” tab.  
 

 
 
Notes can be entered with up to 255 characters each.  When a new note is created, it is automatically tagged 
by date and time of creation.  Double-click in the note text field to enter text for the note.  Notes will be 
displayed in ascending order, i.e., the latest entry is shown at the top and the oldest entry will be at the 
bottom of the list.  The toolbar icons for profile note entry are as follows (order from left to right): 
 

 
 
 
IMPORTANT:  The profile notes are saved with the profile.  After entering a new note or editing existing 

profile notes, you must save the profile to keep the changes.  If you select or create a 
different profile prior to saving the current profile, all updates to the profile notes will be 
lost. 
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2.4.3 Profile Run 

The Profile Run tab allows the user to view the profile operating status of the profile, as well as start, stop and 
hold the currently running profile.  As mentioned previously, EZ-View uses profile 9 of the P-Series only.  
Therefore, only profile 9 can be downloaded to and started.  If another profile is started at the P-Series control 
itself, the operating status of the profile will be shown, and the profile can be placed into hold and stopped 
through EZ-View, but only profile number 9 can be started. 
 

 
 
To start a profile, enter the stage for the profile to start on in the “Enter value for stage to start profile on (0-
63)” field.  Note that a start stage of 0, corresponds to the first stage of the profile.  Click on the “Run” button 
to start the profile.  When a profile is running, the “Run” button will turn bright green to indicate the profile is 
running. 
 
To place the currently running profile in hold, click on the “Hold” button.  When the profile is in hold, the button 
will turn bright green to indicate the profile is in hold.  To resume the profile, click on the “Run” button. 
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2.5 EZT-430i-LC Detail View 

The “EZT-430i-LC Detail View” is accessed from the View menu.  It is a multi-tab interface which is divided 
into three sections and provides direct access to each individual EZT-430i LC attached to the system.  
Available EZT-430i LC controllers are selected from the drop down menu at the top of the screen and are 
listed by device name as assigned on the Device Setup screen for easy identification. 
 
 
2.5.1 Detail View 

The “Detail” view tab provides the user with the current EZT-430i LC “run” data.  This includes all control loop 
process values as well as the current setpoints and percentage of output.  The System Events status 
indicators provide the user with immediate feedback of the current event status.  The current profile name and 
status are also provided. 
 

 
 
To change a loop setpoint, click on the current setpoint in the main digital display area and enter the desired 
value.  EZ-View automatically keeps track of each loop’s min/max setpoint limits as entered in the 
configurator, so if the user enters a value that exceeds the minimum or maximum allowed setpoint, the value 
will be coerced to the corresponding limit value. 
 
When running the system in static mode, the control loop setpoints as well as all system events can be 
accessed and operated by the user.  When running in automatic profile mode, the setpoints and events can 
not be modified.  The Profile Status, Run, Hold and Stop buttons allow the operator to run the currently 
loaded profile from the PC. 
 
The “Data Logging” button provides access to the control’s individual data logging settings.  This allows the 
user to start/stop individual logging of the EZT-430i LC and also choose what parameters are to be logged.  
When logging is active, the button will be highlighted green to provide visual feedback to the user indicating 
the logging status.  See Section 4.0 Data Logging, for more information on the EZ-View data logging features.  
 
The “General Notes” and “Service Notes” buttons provide access to the respective notes entry for the 
controller.  See Section 3.0 Control Notes, for more information on using the EZ-View notes feature.  
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2.5.2 Profile Entry 

Profiles can be created or edited at any time during operation; however, profiles can only be downloaded 
when the selected EZT-430i LC controller is not currently running a profile.  All profiles are saved directly to 
the hard drive of the PC which makes them available for download to any EZT-430i LC control in the system, 
not just the one currently selected. 
 
CAUTION: It is recommended that profiles be created and named for use with specific EZT-430i LC 

controllers in the system and not shared between multiple controllers.  While EZ-View allows you 
to share profiles among multiple EZT-430i LC controls, unless each control is configured 
identically with the same input range, decimal point scaling, events, etc., the profile for one EZT-
430i LC may not operate correctly in another if they are not configured the same. 

 
 The profiles do not store configuration information for the EZT-430i LC, only the sequence of 

stages that are to be performed.  If an attempt is made to download a profile that has setpoint 
limits outside the range of the selected EZT-430i LC control, a download error will occur.  This 
could result in partial profile download, and running it could cause erratic operation. 

 
 
To enter a profile, first enter the number of stages for the profile you intend to program.  This number can be 
changed at any time during the profile entry process.  The total stages entered will then appear in the 
“spreadsheet”.  Note that the last stage of the profile must be an “End” type step.  If the profile requires 10 
stages of ramps and dwells, the total stages will have to be 11 so that the last stage can be entered as an 
“end” stage. 
 
Prior to entering individual stage data, the ramp and dwell units should be set according to the requirements 
for the profile.  The units selected apply to all stages of the profile.  These units can be changed any time 
during profile entry; however, switching ramp units between time and rate will clear the “Ramp Time” entries 
for each stage of the profile, which will require the user to re-enter all of the stage data. 
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The toolbar icons for profile editing are as follows (order from left to right): 
 

 
 
 
2.5.2.1 Global Profile Settings 

 
These settings apply to the entire profile.  The number of stages, HoldBack band, ramp units and dwell units 
can be changed at any time during profile entry.  However, the ramp units should be set prior to entering any 
stage data.  Ramp units can be switched between hours/minutes and minutes/seconds without affecting the 
profile, but changing the ramp units between units of time and rate, will clear all “ramp time” stage entries and 
require the user to re-enter all of the data. 
 
The HoldBack band is also known as a guaranteed soak value.  If holdback is enabled on a profile stage, this 
value will be used as the maximum allowed deviation from setpoint.  If the temperature were to deviate from 
setpoint by more than this value for example, the profile would hold until the temperature falls back within the 
band.  The default value is 1.  If you intend to use “guaranteed soak” in your profile, set this to the desired 
value; otherwise, leave it at the default value. 
 
The Ramp Units define the units used by the EZT-430i LC to ramp the setpoint in ramp stages.  The ramp 
units can be set for units of time in hours and minutes or minutes and seconds.  The units can also be set for 
ramp rate rather than time, i.e., ramp in degrees per hour or degrees per minute; however, the ramp rate 
selections are available on single loop EZT-430i LC units only. 
 
Note that the setting here will be used for each ramp stage of the profile.  If hours and minutes are selected 
(maximum of 59 hours 99 minutes), all ramp time entries will be in hours and minutes.  If minutes and 
seconds are selected (maximum of 59 minutes 99 seconds), all ramp step time entries will be in minutes and 
seconds.  If a ramp rate setting is selected, all ramp stage will have the ramp stage entry made in either 
degrees per hour or degrees per minute. 
 
The Dwell Units define the units of time used by the P-Series in dwell stages.  The dwell units can be set for 
units of time in hours and minutes or minutes and seconds.  Note that the setting here will be used for each 
dwell stage of the profile.  If hours and minutes are selected (maximum of 99 hours 59 minutes), all dwell time 
entries will be in hours and minutes.  If minutes and seconds are selected (maximum of 99 minutes 59 
seconds), all dwell stage time entries will be in minutes and seconds. 
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2.5.2.2 Stage#/Events 
 
The Stage# indicates the current stage active for event editing.  By clicking on a row in the spreadsheet, it 
sets that stage as the active stage. 
 
The Events selections for the stage are made by simply placing a check in the checkbox next to the desired 
event selection.  As different stages are selected for edit, these fields will automatically update to display the 
selections for the current stage.  
 
NOTE: Consult the documentation provided by your OEM regarding any events configured in your EZT-

430i LC controller.  These selections allow you to turn event outputs (if equipped) on and off for 
each stage.  The number of events available for selection are based on the number set in the 
Configurator for the selected EZT-430i LC. 

 
 
2.5.2.3 Entering Profile (Stage) Data 
 
To enter stage data, simply click on the cell in the “spreadsheet” and enter the desired value.  EZ-View will 
limit entries to valid data ranges for time and prevent the user from entering setpoints that exceed the limits 
set for the control loop in the EZ-View Configurator.  Keypad usage (left/right/up/down and entering a 
number) is the same as clicking for fast entry.  
 
The Stage Type defines the type of stage.  Available selections are Ramp, Dwell, Jump and End types.  Note 
that the last stage of the profile must be configured as an End type.  
 
The “Loop” SP entry is required for ramp and end stage types.  This setpoint is used as the target setpoint 
for the stage, i.e., the setpoint the controller will ramp to by the end of the stage.  For the end stage, this 
setpoint is used by the controller once the profile ends if the EZT-430i LC is configured for “Final setpoint of 
automatic program”.  If the EZT-430i LC is configured for “Current control setpoint” as the setpoint at the end 
of profile, the end stage setpoint will not be used and the controller will use the setpoints of each loop prior to 
the start of the profile 
 
For a dwell stage, the value in this field is automatically set to the previous stage setpoint (i.e., the ramp stage 
setpoint).  For jump stages, the setpoint is automatically defaulted to the low setpoint limit for the loop as set 
in the Configurator.  This insures that the setpoint will be within the setpoint limits of the controller for proper 
download to the EZT-430i LC.  Even though the setpoint is not used on a jump stage, it must be within proper 
limits to download correctly to the loop controls. 
 
The Ramp Time entry is required for ramp stage types.  The value entered here will be in units of time or 
rate.  When hours/minutes or minutes/seconds are selected for the ramp entry, the value will be entered as a 
decimal number.  The number preceding the decimal point is the first unit of time (hours or minutes) and the 
number following the decimal point is the second unit of time (minutes or seconds).  If the units selected are 
hours/minutes, an entry of 1.30 for example, is equivalent to 1 hour, 30 minutes. 
 
If ramp rate is selected, the entry will be a whole number representing the change in setpoint per units of time 
in hours or minutes.  For example, if units/minute is selected, an entry of 50 is equivalent to a ramp rate of 50 
degrees per minute. 
 
The Dwell Time entry is required for dwell stage types.  The value entered here will be in units of time as 
hours/minutes or minutes/seconds as selected for the dwell units.  The value will be entered as a decimal 
number.  The number preceding the decimal point is the first unit of time (hours or minutes) and the number 
following the decimal point is the second unit of time (minutes or seconds).  If the units selected are 
minutes/seconds, an entry of 30.00 for example, is equivalent to 30 minutes (00 seconds). 
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The HoldBack type sets the type of guaranteed soak.  This can be entered for ramp or dwell steps.  Note that 
when entering a holdback on a ramp step, the ramp rate can be affected because the profile will hold if the 
process deviates too far from the setpoint.  There are three options for the HoldBack type. 
 
Dev Low: When deviation low is selected, the profile will hold only when the process value falls below the 

soak band [process value < (control setpoint – holdback band)]. 
 
Dev Hi: When deviation high is selected, the profile will hold only when the process value rises above 

the soak band [process value > (control setpoint + holdback band)]. 
 
Band: When band is selected, the profile will hold when the process value rises above or falls below 

the soak band [(setpoint + holdback band) < process value < (setpoint – holdback band)]. 
 
The Jump Step number entry is required for jump step types.  This is the stage that the profile will jump when 
the jump is executed.  Note that the “End” step type can also perform a jump.  This allows you to repeat the 
profile without having to enter a jump step.  Thus, jump steps are only required if you need to repeat sections 
of the profile.  If you want to repeat an entire profile, just set the jump cycles in the end step. 
 
The Jump Cycles entry is required for jump and end stage types.  This is the number of jump cycles to 
perform.  The number of cycles can be set from 1 to 9999.  The value can also be set to 10000 for an infinite 
number of cycles.  If set on the “end” stage of a profile for example, this would cause the profile to run and 
repeat indefinitely until stopped by the user.  Note that a setting of 1 means that no jump is made.  The first 
cycle is completed upon reaching the jump or end step.  Thus, a setting of 1 means do the profile once, so if 
you want the profile to perform 10 cycles, you would set this value to 10.   
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2.5.3 Profile Notes 

Profile notes are accessed from the “Profile Notes” tab.  
 

 
 
Notes can be entered with up to 255 characters each.  When a new note is created, it is automatically tagged 
by date and time of creation.  Double-click in the note text field to enter text for the note.  Notes will be 
displayed in ascending order, i.e., the latest entry is shown at the top and the oldest entry will be at the 
bottom of the list.  The toolbar icons for profile note entry are as follows (order from left to right): 
 

 
 
 
IMPORTANT:  The profile notes are saved with the profile.  After entering a new note or editing existing 

profile notes, you must save the profile to keep the changes.  If you select or create a 
different profile prior to saving the current profile, all updates to the profile notes will be 
lost. 
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2.6 Single Loop tuning 

The Single Loop Tuning window is accessed from the View menu.  It provides the user with an interface to 
access each single loop controller in the system, and initiate the controller’s auto-tune function as well as 
manually adjust tuning parameters.  A trend is provided to monitor PV, SP and %Out through the complete 
tuning cycle.  Note that L91/L41 controllers will not be show up in the control list as they do not have any 
tuning parameters associated with them. 
 

 
 
The screen has fields for viewing and adjusting proportional band, reset, rate, cooling PB and deadband (gap 
between heat and cool control).  The drop down list box located at the top right of the loop tuning window is 
used to select any single loop control in the system to work with. 
 
The “AT” auto tune on/off button on the controller faceplate can be used to activate the auto tune function on 
the controller or to cancel the auto tune.  To activate auto tune, simply click on the button.  When auto tune is 
active, the button will illuminate bright green to indicate the tune is active.  To cancel an auto tune in progress, 
click on the “AT” button once more. 
 
The toolbar icons for loop tuning are as follows (order from left to right): 
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2.7 Digital Values 

The Digital Values window is accessed from the View menu.  It displays all tags for all controllers activated in 
the system.  The digital values window can be printed on demand by clicking on the "Print" icon.  The setpoint 
of each individual control loop, including those of each EZT-560/570i and EZT-430i in the system, can be 
changed by clicking on the setpoint field in the digital list view, and entering the new value.  EZ-View 
automatically keeps track of each loop’s min/max setpoint limits as entered in the configurator, so if the user 
enters a value that exceeds the minimum or maximum allowed setpoint, the value will be coerced to the 
corresponding limit value. 
 

 
 
 

2.8 System Alarm Log 

The system alarm log keeps track of all alarms in the system.  The alarm window will display all alarms from 
each EZT, as well as alarm2 of the 100 and 300 series controllers, the limit alarm of L91/L41 controls and 
alarms 2 and 3 of the P-Series control.  The alarm log window will automatically maximize itself upon any new 
system alarm (even if the window is minimized). 
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Double clicking on any alarm will display a dialog confirming if the user wants to acknowledge the alarm.  
Upon selected “Yes” and acknowledging the alarm, the EZT’s local audible alarm output will be silenced.  
This provides operators with the ability to silence local device alarms.  Alarms can only be cleared from the 
system alarm log if the alarm has been acknowledged through EZ-View or locally at the EZT, and the alarm 
condition no longer exists.  If an alarm has been acknowledged, but will not clear using the “Clear Single 
Alarm” or “Clear All Alarms” buttons, then the alarm condition is still present and must be corrected before the 
alarm will clear.  
 

 
 
NOTE: Acknowledging alarms from EZ-View does not turn the EZT-560/570i screen from the red alarm 

background to blue, or clear the alarm from the EZT alarm monitor screen.  You can only 
acknowledge the alarm and silence the EZT audible alarm once. 

 
For the EZT-430i, acknowledging alarms at EZ-View will also silence the local GUI alarm, but it 
does not clear the alarm from the alarm screen or hide the alarm icon.  The alarm icon will continue 
to flash to in order to alert operators locally, that an alarm has occurred. 

 
 
The toolbar at the top of the alarm screen provides the following functions (from left to right): 
 

 
 
 
2.8.1 Alarm Log Viewer 

The Alarm Log Viewer allows the user to view historical, daily system alarm logs in tabular format.  This data 
can then be printed or exported to a .csv file. 
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Alarm logs are created and written to daily, whenever an alarm occurs.  Note that to activate alarm logging, 
the user must check the "Enable alarm logging" checkbox in the "Device Setup" screen. 
 
The toolbar at the top of the alarm screen provides the following functions (from left to right): 
 

 
 
 
2.8.1.1 Custom Alarm Reports 
 
The Custom Alarm Report feature of the alarm log viewer, allows the user to search all alarm log files stored 
on the hard disk for a particular text string.  The text can be an alarm name, particular device or even a date 
or time.  When the custom alarm report is selected from the toolbar, the search window will be shown. 
 

 
 
Enter in the desired text string to search for and press the “OK” button to begin the search.  To close the 
search window, press the “Cancel” button.  Once the search is started, the alarm log viewer will be populated 
with entries found in each alarm log that have a matching entry for the search string.  A progress bar will be 
shown at the top right of the alarm log viewer window to update the user on the search progress. 
 

 
 
Depending upon the search string and number of alarm logs present on the hard disk, the search could take 
an extended amount of time.  The search can be cancelled at any time by pressing the “Cancel Custom 
Report” button on the toolbar.  Once the search is complete, the number of occurrences of the search string 
found, will be shown at the bottom left of the window. 
 
NOTE: While the custom report is being created, the user can navigate to different view screens or perform 

other tasks.  The search will continue in the background and allow the user to come back and view 
the data at a later time. 
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2.9 Real Time Trends 

Up to eight real time trends can be active at any time.  Up to 12 channels can be assigned to any trend.   
Dragging on the trend scale (left side of trend) or trend time (bottom of trend) allows the user to interactively 
change the trend scale or move forward/backward in time to view trend data. 
 

 
 
The -100 to +100 scales at the bottom and to the right of the trend are for scale/time compression/expansion.  
This is an analysis tool to "zero" in on specific data in the trend.  It's a zoom in/out adjustment for the trend 
scale and time scale. 
 
The toolbar at the top of the trend screen provides the following functions (from left to right): 
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2.9.1 Chart Annotation 

The default chart annotation for a trend plot is “Real Time Trend”.  This can be changed be pressing the “Edit 
Chart Text” button on the trend toolbar.  When pressed, the Chart Annotation dialog box will be shown.  The 
user can then enter a description for the real time trend with up to 255 characters.   
 

 
 
When complete, press the “done” button to replace the current text with that entered; otherwise, press the 
“Cancel’ button to exit without making any change. 



                           EZ-View 

2.38 EZ-View                 MONITORING AND CONTROLLING DEVICE OPERATIONS 

2.9.2 Trend Setup 

The Trend Scaling Setup window is accessed from the Setup Trend toolbar button on the trend view.  From 
this window, the user can adjust the vertical (Y) and horizontal (X) axis and select which data values to 
display on the trend. 
 

 
 
Each control trend will remember its last display settings and will use them the next time the trend is 
displayed.  EZ-View also allows each trend setup to be saved to a file, so that a single trend can display 
different data and ranges by simply selecting a different trend view file. 
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2.10 Logging Overview 

The Logging Overview is accessed from the View menu.  This allows the user to monitor the logging status of 
all devices from a single screen.  When logging is active for a device, the respective log status button will be 
highlighted green.  In addition, the current log file name will be shown. 
 

 
 
By clicking on the log status button for a particular device, the logging setup window for the device will be 
shown allowing the user to start/stop logging for the device as well as select which parameters are to be 
logged.  See Section 4.0, Data Logging, for more information on using the EZ-View data logging feature.  
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2.11 Thumbnails 

Controller Thumbnails are accessed from the Thumbnails menu.  The thumbnails allow the user to monitor 
many controllers at the same time by lining up multiple thumbnails on the screen.  This provides a "quick" 
view of specific controllers attached to the system. 
 

 
 

Thumbnails consist of 4 controllers per bank. Process value (red), setpoint (green) and controller status are 
provided.  Each thumbnail will be updated to show the profile run, hold and stop status as well as current step 
active and time remaining.  Note that the Run, Stop and Hold buttons used for the profile operation will not be 
visible. These functions must be accessed from the EZT-560/570 Detail View, EZT430i Detail View or P-
Series Profiler screen. 
 
The drop down menu allows the user to select any of the loops or monitor points on an EZT-560/570i or 
EZT430i controller for display on the thumbnail.  Single-loop controls only provide a single selection for the 
process variable, since there is only one associated with the controller.  To change the loop’s setpoint, click 
on the current setpoint and enter the desired value.  EZ-View automatically keeps track of each loop’s 
min/max setpoint limits as entered in the configurator, so if the user enters a value that exceeds the minimum 
or maximum allowed setpoint, the value will be coerced to the corresponding limit value. 
 
The “General Notes” and “Service Notes” button on each device thumbnail, provide access to the respective 
notes entry for the controller.  See the following Section 3.0 Device Notes, for more information on using the 
EZ-View notes feature. 
 
The “Logging” button on each device thumbnail, provides access to the respective data logging settings for 
the controller.  When logging is active for the device, the button will be highlighted green to provide a quick 
visual indication to the user indicating the logging status for the device.  See Section 4.0, Data Logging, for 
more information on using the EZ-View data logging feature.  
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3 Device Notes 

EZ-View provides the user with the ability to enter both general and service notes, for each controller in the 
system.  The note files are saved individually per control, so that the use and maintenance history of each 
can be tracked.  The general or service note entry is accessed from Thumbnails view via the “General Notes” 
and “Service Notes” buttons.  
 

 
 
When either the general or service notes button is pressed, the notes entry window is displayed.  The header 
of the window will indicate which notes file is being edited, general or service, and which controller they are 
being edited for. 
 
Notes can be entered with up to 255 characters each.  When a new note is created, it is automatically tagged 
by date and time of creation.  Double-clicking in the note text field will allow the user to enter text for the note.  
Notes will be displayed in ascending order, i.e., the latest entry is shown at the top and the oldest entry will be 
at the bottom of the list. 
 
The toolbar icons for note entry are as follows (order from left to right): 
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4 Data Logging 

EZ-View is equipped with both system data logging and individual device data logging capabilities.  This 
provides the user with the ability to log data according to individual controller use, but also maintain a 
complete system log for uninterrupted data regardless of controller use.   
 
 

4.1 System Data Logging 

The System Data Logging settings are accessed from the Setup menu.  The system data logger can record 
and save data from all controllers attached to the system. 
 

 
 

All available data points from each controller can be individually selected for logging by clicking on the 
checkbox next to the variable’s tagname and placing a red “check” in the box.  The “Select All” and “De-
Select All” buttons allow the user to quickly select all points for logging or de-select all points to make it 
easier to select just a few points for system logging. 
 
NOTE: A maximum of 256 points can be selected for the system data logging file.  If there are more than 

256 points, the “Select All” button will only activate the first 256 points.  
 
The “Storage Directory” button allows the user to select the directory that will be used for storing the system 
log files.  See Section 4.3 Selecting the Data Logging Storage Directory, for more information regarding this 
option. 
 
The “Data log interval in seconds” can be set from 1 seconds to 3600 seconds (60 minutes).  When the 
system data logging is started, EZ-View will then record all selected variables to the data log file once per the 
set interval period. 
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The "Batch# and Lot#" field data (if entered) will be written to the first line of the data file.  EZ-View’s data 
file viewer has a "search" function to allow the user to look for data that matches a specific batch number for 
example.   This can allow the user to quickly search and find data associated with a certain batch run.  
 
The "Start Log" button will start the system data logging process.  If the "Generate log file using date/time:" 
checkbox is enabled, data logging will start using the current date and time as the file name.  Otherwise, a 
dialog box will be shown to allow the user to assign a specific name to the data log file. 
 
The "Stop Log" button will stop the data logging process.  
 
The "Generate log file using date/time:" checkbox allows the system to assign a data filename 
automatically using date and time stamps for the filename.  When this checkbox is enabled a new data file will 
be started at 12:00 midnight daily. 
 
When unchecked the log file will continue until it reaches 65,000 entries.  At this point, the log file will be 
closed and digitally signed by EZ-View.  A new log file will then be created for the system using the current 
data and time, and logging will automatically continue to the new file.  This allows a single file to cover a 
period of ~90 hours (5 second log interval) to ~2700 days (3600 second log interval). 
 
The "Initiate data logging at startup:" checkbox allows EZ-View to automatically start the system data 
logging (with date/time filename) when it is first started.  Note that the “Generate log file suing date/time” will 
be automatically checked when using this option. 
  
The "Current File Name Active" label will display the filename of the currently running data file.  This label 
will be empty if no data file is active. 
 
Once all selections have been made, press the “Save Setup” button to record all changes to the data logging 
setup.  If the system data logging setup screen is closed without pressing the save button, all changes to the 
logging setup will be lost.  To exit the screen, press the “Done/Close” button. 
 
NOTE: Once data logging is started, all logging options will be “locked” to prevent the file from being altered 

while it is running.  This protects the data log file from having additional data added or removed 
during product runs.  To make changes to the system logging selections, logging must be stopped. 

 
 
4.1.1 System Operator Message 

When the system data logger is running, EZ-View allows the user to enter status messages that are saved to 
the system data log file.  This allows daily events, product movement or shift changes, to be logged and 
tracked.  These messages are inserted into the log file with a date/time stamp so that they can be reviewed 
along with the historical data using EZ-View’s data viewer. 

 

 
 

To enter an operator message, select “System Operator Message” from the Users menu.  Enter in the 
desired message text and select “OK”.  The message will then be inserted into the system data log file and 
the window will close.  To exit the operator message window without saving a message to the log file, press 
the “Cancel” button. 
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4.2 Device Data Logging 

The individual controller data logging settings are accessed from the Logging Overview and the controller 
Thumbnails.  Each controller has its own individual data logger that can be configured and operated 
independently of the system data logger as well as other devices in the system. 

 

 
 
All available data points from the controller can be individually selected for logging by clicking on the 
checkbox next to the variable’s tagname and placing a red “check” in the box.  The “Select All” and “De-
Select All” buttons allow the user to quickly select all points for logging. 
 
The “Storage Directory” button allows the user to select the directory that will be used for storing the system 
log files.  See Section 4.3 Selecting the Data Logging Storage Directory, for more information regarding this 
option. 
 
The “Data log interval in seconds” can be set from 1 seconds to 3600 seconds (60 minutes).  When the 
device data logging is started, EZ-View will then record all selected variables to the data log file once per the 
set interval period. 
 
The "Batch# and Lot#" field data (if entered) will be written to the first line of the data file.  EZ-View’s data 
file viewer has a "search" function to allow the user to look for data that matches a specific batch number for 
example.   This can allow the user to quickly search and find data associated with a certain batch run.  
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The “Data log on profile run” checkbox can be checked for EZT-560/570i controllers.  When checked, data 
logging will automatically start and stop for the device based on profile operation.  This creates log files that 
contain data pertaining only to profile operation, so that users do not have to scan through continuous log 
files to locate information pertaining only to a profile run. 
 
The “Data log on digital input” checkbox can be checked for EZT-430i CM controllers.  When checked, 
data logging will automatically start and stop based on the digital input configured on the EZT-430i CM that 
controls logging operation. 
 
The “Alarm log interval” can be set from 1 second to 3600 seconds (60 minutes).  When an alarm is active 
on the device and data logging is running, EZ-View will use this logging interval to record data while the alarm 
condition is active.  This allows a faster logging rate to be used during alarm conditions in order to record 
minimum or maximum excursions that may occur during the alarm condition.  Once the alarm condition 
clears, EZ-View will revert back to the normal data log interval. 
 
The "Start Log" button will start the data logging process for the controller.  When started, a dialog box will 
be shown which allows the user to name the data log file and/or select a location on the computer’s hard drive 
to save the file.  By default, the selected storage directory will be selected as the primary storage location for 
the file, and a default file name is assigned using the device name and current date and time. 
 
Logging will continue until stopped by the user.  Once a log file reaches 65,000 entries, the current log file will 
be closed and digitally signed by EZ-View.  A new log file will then be created for the device using the current 
data and time, and logging will automatically continue in the new file.  This allows a single file to cover a 
period of ~90 hours (5 second log interval) to ~2700 days (3600 second log interval). 
 
The "Stop Log" button will stop the controller data logging process.  
 
The "Batch# and Lot#" field data (if entered) will be written to the first line of the data file.  EZ-View’s data 
file viewer has a "search" function to allow the user to look for data that matches a specific batch number for 
example. 
 
Once all selections have been made, press the “Save Setup” button to record all changes to the data logging 
setup.  If the device data logging setup screen is closed without pressing the save button, all changes to the 
logging setup will be lost.  To exit the screen, press the “Done/Close” button. 
 
NOTE: Once data logging is started, all logging options will be “locked” to prevent the file from being altered 

while it is running.  This protects the data log file from having additional data added or removed 
during product runs.  To make changes to the device logging selections, logging must be stopped. 

 
 
4.2.1 Operator Message to File 

When the device data logger is running, EZ-View allows the user to enter status messages that are saved to 
the data log file.  This allows daily events, product movement or even shift changes to be logged and tracked.  
These messages are inserted into the log file with a date/time stamp so that they can be reviewed along with 
the historical data using EZ-View’s data viewer. 

 
To enter an operator message, type the desired message text into the “Operator Message To File” field on 
the device Logging Setup screen and press the “Save” button.  The message will then be inserted into the 
device data log file. 
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4.3 Selecting the Data Logging Storage Directory 

EZ-View provides the option of selecting individual storage directories for each individual device as well as 
the system log file.  By default, EZ-View stores all data log files in the “Log Files” directory under EZ-View’s 
installation folder. 
 
When clicking on the “Storage Directory” button on either the system or device logging setup screen, the 
“browse folder” window will be shown.  The current log file storage path and folder will be displayed.  The user 
can then navigate to any folder on the PC, as well as any available network drives and folders to choose a 
location for the files to be stored.  Once the desired storage location has been chosen, press the “OK” button 
to close the window.   
 

 
 
NOTE: In order for EZ-View to begin using the new storage path, the logging setup for the device (or 

system log) must first be saved.  This prevents he storage path from being altered while logging is 
currently active for the device or system.  

 
 
4.3.1 Using Network Storage Locations 

Using a network storage location can provide the convenience of centralized data storage and back-up.  
However, when using a “remote” storage location, the network must be readily available and active at all 
times.  If there are interruptions in the network connection, or heavy traffic consumes most of the bandwidth, 
data logging can be interrupted or fail if the connection to the drive is lost. 
 
In these instances, if a logging error should occur, the system alarm log will note the error and bring it to the 
attention of the user.  Even in doing so, data for the time period will be lost and not recorded.  Local data 
logging to the PC running EZ-View is the fastest and most reliable means of logging data, and is the 
recommended method. 
 
However, if data loss is a concern, there are numerous back-up utilities available that can be loaded on to the 
PC, and set to perform scheduled back-ups which can save the local log files to other network locations and 
prevent data loss in the event of PC failure.  
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5 Historical Data Viewing 

The historical “Data File Viewer” is accessed from the View menu and provides the ability to view all system 
and device data files without leaving the application.  The data viewer displays saved data in a spreadsheet 
format.  The different data cells can be selected for printing or plotting without additional setup.  To view a 
data file, select “Data File Viewer” from the View menu. 
 

 
 
From the Data File Viewer window, the user can open any historical data file saved on the computer.  When a 
file is opened, the “spreadsheet” will be filled with the logged data including the date and time that each point 
was recorded.  The header of each column will show the name of each data point so that they can be easily 
identified.  Groups of cells can be selected (dragged) for printing and/or plotting to a trend. 
 
Select cells as you would in a normal spreadsheet.  Clicking on the column header selects the whole column, 
dragging across cells selects only the cells that the mouse was dragged across.  You can select multiple 
columns by clicking on a column header and dragging to the right or left across other column headers. 
Discontinuous data can be selected by using the "Ctrl" key while selecting data.  You must select at least 4 
cells per column before a plot can be generated. 
 
The Electronic Signatures grid, below the data grid, is used to electronically sign data files.  Electronic 
signatures eliminate the need for paper signatures.  Files can only be signed by users with the proper log in 
and user access.  EZ-View can validate any electronic signature and verify if the original data file (when 
signed) has been altered in any way. 
 
 
NOTE: Electronic signatures can only be assigned to files if security is enabled and the user has authentic 

security access and is logged in to the system. 
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The toolbar icons for data file viewing are as follows (order from left to right): 
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5.1 Searching Historical Data Files 

The historical Data File Search feature of the data file viewer, allows the user to search all data log files in a 
particular directory, or all known directories based on device logging configurations, for a particular text string.  
The text can be a batch number, lot number, user name, particular operator message or even a date or time.   
 

 
 
To begin a search, enter in the desired text string to search for, and press the “Start” button to begin the 
search.  By default, EZ-View will search all known log file directories for files containing the search string.  If 
only a particular directory is to be searched, placing a check in the “Select data search directory” checkbox 
prior to starting the search, will cause EZ-View to prompt the user for the particular directory to search in. 
 
To close the search window, press the “Close” button.  Once the search is started, the data file search list will 
be populated with files that contain entries that match the search string.  A progress bar will be shown at the 
bottom left of the window to update the user on the search progress.  Depending upon the search string and 
number of data files to be searched, the search could take an extended amount of time.  The search can be 
cancelled at any time by pressing the “Cancel” button. 
 
Once the search has been completed, the user can then select from any of the files in the list by clicking 
anywhere on the row for the desired file.  The file will can then be opened and the data displayed in the Data 
File Viewer. 
 
NOTE: While the file search is running, the user can navigate to different view screens or perform other 

tasks.  The search will continue in the background and allow the user to come back and view the 
data at a later time. 
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5.2 Historical Trend Plot 

This historical trend plot provides a graphic view for historical data.  Data selected in the data viewer will be 
plotted on the trend.  The only limit to the number of channels is the size of the window to view the data and 
computer memory.  Dragging on the trend scale (left side of trend) or trend time (bottom of trend) allows the 
user to interactively change the trend scale or move forward/backward in time to view historical trend data. 
 
The -100 to +100 scales at the bottom and to the right of the trend are for scale/time compression/expansion.  
This is an analysis tool to "zero" in on specific data on the trend.   It's a zoom in/out for the trend scale and 
time scale.  In the historical plot, these scales are real time so the data will move as you adjust the zoom 
level. 
 

 
 
The toolbar at the top of the trend screen provides the following functions (from left to right): 
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NOTE: The trend setup only allows the user to change plot colors, the range of the vertical axis and the 

displayed time format.  Since the trend only displays the data selected from the historical data file, 
all other selections are “fixed” to the data chosen to plot.  In order to add or removed data from the 
historical tend plot, the selections must be made from the data file viewer spreadsheet. 

 
 
5.2.1 Chart Annotation 

The default chart annotation for a history plot is the current data log file.  This can be changed be pressing the 
“Edit Chart Text” button on the history plot toolbar.  When pressed, the Chart Annotation dialog box will be 
shown.  The user can then enter a description for the history plot with up to 255 characters.   
 

 
 
When complete, press the “done” button to replace the current text with that entered; otherwise, press the 
“Cancel’ button to exit without making any change. 
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6 Security 

EZ-View's security features are not just applicable to the pharmaceutical industry.  Any industry that requires 
secure data files, audit trails and authenticated logins to initiate process changes can take advantage of these 
features.  The security can also be turned off for companies that do not require security in their systems. 
 
 

6.1 Configure Security 

The “System Security” settings are accessed from the Setup menu.  It is a multi-tab interface which is divided 
into three sections. 
 

 
 
The Add User tab provides the ability to add up to 30 users to the system.  To enter a new user, select the 
type of user from the “Select User Group” drop down list (System, Operator, Supervisor and Administrator 
levels are available).  Enter the user ID, full name and password for the user.  The user ID and password 
must be at least 6 characters long and can not include spaces or commas “,”. 
 
Check the password aging checkbox to enable password aging for the user.  If password aging is enabled 
and the password has expired, the user will be prompted to enter a new password before they can log into 
the system again. 
 
Once all entries have been made, press the “Create User” button to add the user to the system.  If the 
password and confirm password entries do not match, or the user ID is already used, EZ-View will alert the 
user and not accept the entry. 
 
 
6.1.1 Users 

The “Users” tab provides the ability to view information on each user entered into the system.  Password 
information is not available. 
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Users can be deleted from the system by selecting the user from the list and pressing the “Delete User” 
button.  Note that one a user is deleted, it is gone and can not be restored without re-entering all information 
on the Add Users tab and re-creating the user. 
 
 
6.1.2 Rights and Options 

The "Rights and Options" tab provides the ability to set security access rights for each user level as well as 
enable and disable security options. 
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The User Level list box is used to select the user level you wish to assign rights to.  The access rights for the 
selected user level will be shown in the “User Rights” list box.  As different user levels are selected, the 
selected user rights will update accordingly. 
 
NOTE: The “system” user level refers to the default access rights the software provides on start up when 

no user is logged into the system.  Typically, the user rights for the system level would be set to 
minimal, or no access, to prevent any interaction with the system without having a user first log in.  
In most cases, users are only assigned to the operator, supervisor or administrator levels. 

 
 
The User Rights check/list box allows is used to set the security options for the specific user level selected.  
When checked, the user level has access rights to that item.  When unchecked, the user level will not have 
access rights for that item.  The “Select All” and “Remove All” buttons provide a quick method for enabling or 
disabling all user rights for the selected user level. 
 
NOTE: When making changes to user level access rights, be sure to press the "Accept" button under the 

user level list box prior to selecting another user level or exiting the security settings window in 
order to save the updated user rights.  If you do not press “Accept” prior to selecting a different user 
level or exiting security settings, any changes made to the user rights will be lost. 

 
 
The Enable Security checkbox is used to enable or disable all security features.  If this checkbox is 
unchecked, all software functionality is available to any user on the system without login or password check. 
 
The Enable Audit Trail checkbox is used to enable or disable the audit trail.  If this checkbox is unchecked, 
the audit trail data for each user action will not be written to the audit trail log and will not be accessible for 
viewing.  Note that in order to enable the audit trail feature, security must be enabled. 
 
The Enable Re-Authentication checkbox is used to enable or disable the re-authentication feature.  If this 
checkbox is checked, users will be required to login again (even if already logged on) before changing 
setpoints or making other process changes in the system.  This feature offers dual protection against 
unwanted system changes that might adversely affect controller operation. 
 
The Enter Number Of Days Before Password Renewal Is Required entry is a global setting for all users.  
Users created with password aging enabled, will be required to renew their password on regular intervals as 
defined by this setting.  The password aging interval begins from the moment a user is entered into the 
system. 
 
The Auto Log Out Enable/Disable checkbox is used to enable the auto log out feature.  This is a global 
setting for all users.  When checked, if there is a period of inactivity by the current user logged into the 
system, i.e., no mouse or keyboard activity, the user will be automatically logged out and EZ-View will default 
to the system security level. 
 
The Auto Log Out Time (in seconds) is used to set the period of inactivity for the auto log out feature.  The 
auto log out time can be set from 10 seconds to 86400 seconds (24 hours).   
 
 
NOTE: When using the auto log out feature, certain screen saver/power scheme combinations of the 

Windows operating system may interfere with the log out inactivity period and prevent the auto log 
out from functioning.  It is recommended that when the auto log out feature is enabled, the screen 
saver activation and power scheme monitor off delay times are set longer than the auto log out 
time. 
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6.1.2.1 System Security User Rights  
 
The following table provides a list of the available user rights in EZ-View, where to find the menu/item(s) 
applicable to the user right and a description of what it applies to. 
 

User Right Menu/Item Location Description 

Open Alarm log Alarm Log Viewer; Open Alarm Log Button access to open and view historical alarm log files 

Silence Alarm View/Alarm Log; Silence Beeper button allows the computer “beep” on new alarms to be 
silenced 
 
Note:  If “beep until any alarm is acknowledged” is 
enabled, the operator will be unable to stop the 
computer beep without access. 

Acknowledge Alarm View/Alarm Log allows controller alarms to be acknowledged and 
silences local audible alarm at the EZT-560/570i 

Clear Alarm View/Alarm Log; Clear Alarm button allows the selected alarm to be cleared from the 
system alarm log 
 
Note:  This does not affect historical alarm logs. 

Clear All Alarms View/Alarm Log; Clear All Alarms button allows all alarms to be cleared from the system 
alarm log 
 
Note:  This does not affect historical alarm logs. 

Export Alarms View/Alarm Log & Alarm Log Viewer; Export 
Alarm Log button 

allows a copy of the alarm log to be made in a .csv 
format  

Print Alarms View/Alarm Log & Alarm Log Viewer; Print 
Alarm Log button 

allows the current alarm log to be printed 

Access Device Detail View/EZT-560/570 Detail View, EZT-430i 
Detail View 

access to all individual EZT controls, profile editing, 
data log setup, setpoints, alarm settings, etc. 
 
Note:  In order to edit any individual EZT settings 
(logging, setpoints, profiles, etc.), this user right 
must be enabled.  To allow specific access to 
certain settings, use the Device user rights listed 
below. 

Edit Device Setpoints EZT-560/570 Detail View – Detail tab, EZT-
430i Detail View – Detail tab, Digital Values, 
Single Loop tuning 

applies to all control loop setpoints (does not apply 
to alarm settings) 
 
Note:  Does not prohibit setpoint changes from 
Single Loop Tuning screen.  To prevent setpoint 
changes from loop tuning screen, use the Edit 
Single Loop Tune security item.   

Edit Device Events EZT-560/570 Detail View – Detail tab, EZT-
430i Detail View – Detail tab; Update system 
events button 

applies to turning system events on and off 

Run Schedule EZT-560/570 Detail View – Detail tab; Run 
button (profile control), P-Series Profiler – 
Profile Run tab; Run button, EZT-430i Detail 
View – Detail tab; Run button 

applies to starting a profile 

Stop Schedule EZT-560/570 Detail View – Detail tab; Stop 
button (profile control), P-Series Profiler – 
Profile Run tab; Stop button, EZT-430i 
Detail View– Detail tab; Stop button 

applies to stopping a currently running profile 

Hold Schedule EZT-560/570 Detail View – Detail tab; Hold 
button (profile control), P-Series Profiler – 
Profile Run tab; Hold button, EZT-430i 
Detail View– Detail tab; Hold button 

applies to placing a currently running profile in hold 

Adv Sched Next Seg EZT-560/570 Detail View - Detail tab; 
Advance Next button (profile control) 
 

access to advance to the next stage of a profile 
when it is placed in hold 

Adv Sched Prev Seg EZT-560/570 Detail View – Detail tab; 
Advance Prev button (profile control) 

access to advance to the previous stage of a profile 
when it is placed in hold 
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User Right Menu/Item Location Description 

Create Schedule EZT-560/570 Detail View – Profile Entry tab; 
New Profile button, P-Series Profiler – 
Profile Entry tab; New Profile button, EZT-
430i Detail View – Profile Entry tab; New 
Profile button 

applies to creating a new profile from a “blank slate” 

Open Schedule  EZT-560/570 Detail View – Profile Entry tab; 
Open Profile button, P-Series Profiler – 
Profile Entry tab; Open Profile button, EZT-
430i Detail View – Profile Entry tab; Open 
Profile button 

applies to opening existing profile files saved on the 
hard disk 

Save Schedule EZT-560/570 Detail View – Profile Entry tab; 
Save Profile button, P-Series Profiler – 
Profile Entry tab; Save Profile button, EZT-
430i Detail View – Profile Entry tab; Save 
Profile button 

allows profiles to be saved to the hard disk 

Edit Schedule EZT-560/570 Detail View – Profile Entry tab, 
P-Series Profiler – Profile Entry tab, EZT-
430i Detail View – Profile Entry tab 

access to create/delete profile stages, change 
setpoints, events, guaranteed soak, wait for 
selections and time 

Download Schedule EZT-560/570 Detail View – Profile Entry tab; 
Download Profile to CM button, P-Series 
Profiler – Profile Entry tab; Download Profile 
to Device button, EZT-430i Detail View – 
Profile Entry tab; Download Profile to Device 
button 

allows the downloading of the current profile to the 
controller 

Upload Schedule EZT-430i CM Detail View – Schedules tab; 
Upload Schedule from CM button 

allows a schedule currently loaded in the EZT-430i 
CM controller to be uploaded to the schedule editor  

Export Schedule EZT-560/570 Detail View – Profile Entry tab; 
Export Profiles button, EZT-430i Detail View 
– Profile Entry tab; Export Profiles button 

creates a copy of the current profile that can be 
saved to a different location 

Print Schedule EZT-560/570 Detail View – Profile Entry tab; 
Print Profile Grid button, P-Series Profiler – 
Profile Entry tab; Print Profile Grid button, 
EZT-430i Detail View – Profile Entry tab; 
Print Profile Grid button 

allows the profile grid to be printed in table format 
to a printer 

Edit Device Alarms EZT-430i CM Detail View – Setup/Alarm 
Settings tab 

applies to all EZT-430i CM alarm setpoints and 
alarm types and delay times 

Edit Single Loop Tune View/Single Loop Tuning applies to all tuning parameters, auto tune 
activation and setpoint edit 

Schedule Power Recovery EZT-430i CM Detail View – Setup/Sched 
Options tab 

applies to all profile power recovery settings 

Access Device Logging EZT-430i CM Detail View – Detail tab; Data 
Logging button, EZT-430i LC Detail View – 
Detail tab; Data Logging button, Thumbnails 
– Logging button 

access to individual device data logging settings 
 
Note: In order to add operator messages to the 
data log file, this user right must be enabled.  To 
prevent starting/stopping of the data log file, use 
the Logging Setup user rights listed below. 

Save Device Log Setup Logging Setup; Save Setup button allows device data logging setup selections to 
be saved and used for logging operations 

Start Device Log Logging Setup; Start Log button access to start individual device log file 

Stop Device Log Logging Setup; Stop Log button access to stop individual device log file 

Device Log Operator Message Logging Setup access to add operator events to active device log 
file 

Access General Notes EZT-430i CM Detail View, EZT-430i LC 
Detail View & Thumbnails; General Notes 
button 

access to individual device notes 
 
Note: in order to add/delete or view general notes, 
this user right must be enabled.  To prevent editing 
of the general notes file, use the General Notes 
user rights listed below. 
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User Right Menu/Item Location Description 

Create New General Note General Notes; Create New Note button applies to creating a new general note entry 
 
Note: If the “save general notes” user right is not 
enabled in conjunction with this user right, the note 
will not be able to be saved once entered. 

Delete General Note General Notes; Delete Selected Note button applies to deleting a selected general note entry 
 
Note: If the “save general notes” user right is not 
enabled in conjunction with this user right, the 
notes file will not be able to be saved and the note 
will not be deleted. 

Save General Notes General Notes; Save Notes button applies to saving the general notes file to hard disk 

Export General Notes General Notes; Export Notes button allows a copy of the general notes file to be made 
in .txt format that can be saved to a different 
location 

Print General Notes General Notes; Print Notes button allows the notes file to be printed in list format to a 
printer 

Access Service Notes EZT-430i CM Detail View, EZT-430i LC 
Detail View & Thumbnails; Service Notes 
button 

access to individual device notes 
 
Note: in order to add/delete or view service notes, 
this user right must be enabled.  To prevent editing 
of the service notes file, use the Service Notes user 
rights listed below. 

Create New Service Note Service Notes; Create New Note button applies to creating a new service note entry 
 
Note: If the “save service notes” user right is not 
enabled in conjunction with this user right, the note 
will not be able to be saved once entered. 

Delete Service Note Service Notes; Delete Selected Note button applies to deleting a selected service note entry 
 
Note: If the “save service notes” user right is not 
enabled in conjunction with this user right, the 
notes file will not be able to be saved and the note 
will not be deleted. 

Save Service Notes Service Notes; Save Notes button applies to saving the service notes file to hard disk 

Export Service Notes Service Notes; Export Notes button allows a copy of the service notes file to be made in 
.txt format that can be saved to a different location 

Print Service Notes Service Notes; Print Notes button allows the notes file to be printed in list format to a 
printer 

Access Digital Values View/Digital Values applies to viewing of all system data values in a 
grid format 

Print Digital Values Digital Values; Print Digital Values button allows the list of digital values to be printed 

Access Real Time Trends View/Real Time Trends/Trend 1 - 8 allows access to view real time trend data 
 
Note: In order to view current operating data in 
trend format, this user right must be enabled.  To 
limit access to trend setup, etc., use the Trend 1-8 
user rights listed below. 

Open Real Time Trend Files Trend 1-8; Open Trend View button applies to opening previously saved trend setups 

Setup Real Time Trends Trend 1-8; Setup Trend button allows access to trend setup including colors, axis 
ranges and plot points 

Save Real Time Trend Trend 1-8; Save Trend View button applies to saving current trend setups to hard disk 

Real Time Trend to Jpeg Trend 1-8; Save As Jpeg button allows current snapshot of current trend to be 
saved as a picture file 

Print Real Time Trend Trend 1-8; Print Trend button allows current snapshot of trend to be printed 

Access Data Viewer View/Data File Viewer allows access to the historical data file viewer 
 
Note: In order to digitally sign a data file or view any 
historical data, this user right must be enabled.  To 
allow specific access to historical data files, use the 
Data File Viewer user rights listed below. 
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User Right Menu/Item Location Description 

Open Data Log Files Data File Viewer; Open History File button allows access to historical data files 

Check Digital Signatures Data File Viewer; Verify Signature button access to verify digital signatures of current 
historical data file  

Sign Data Files Data File Viewer; Sign File button access to add digital signature to current historical 
data file 

Export Data Files Data File Viewer; Export Data button allows a copy of the data file to be created in .csv 
format and saved to a different location 

Search Data Files Data File Viewer; Search Data Files button allows access to the data file search 

Print Data Files Data File Viewer; Print History Grid button allows data file to be printed in a table format 

Setup History Trend History Trend Plot; Trend Setup button allows access to trend setup including colors, axis 
ranges and time format of the historical plot 

History Trend to Jpeg History Trend Plot; Save As Jpeg button allows historical plot to be saved as a picture file 

Print Historical Trend History Trend Plot; Print Trend button allows historical plot to be printed 

Access Audit Trail View/Audit Trail Viewer allows access to view the current audit trail 
information for the day 
 
Note: In order to view user interactions for the day 
or to view past user interactions, this user right 
must be enabled.  To limit access to audit trail data, 
use the Audit Trail Viewer user rights listed below. 

Open Audit Files Audit Trail Viewer; Open Audit Trail button allows access to open previous audit trail files 

Export Audit Files Audit Trail Viewer; Export Audit Trail button allows a copy of the current audit trail file to be 
created in .csv format and saved to a different 
location 

Print Audit Files Audit Trail Viewer; Print Audit Trail button allows the current audit trail file to be printed 

Thumbnails View Thumbnails/Devices 1 to 128 applies to all individual thumbnail views 

Access Device Setup Setup/Device Setup provides access to all device settings for controllers 
configured in the system, scan rates and alarm 
notifications 

Save Device Setup Device Setup; Done button allows the current selections for device enable 
status to be saved 

Access System Logging Setup/System Data Logging access to system data logging settings 
 
Note: In order to start or stop system data logging, 
access to this user right must be given.  To prevent 
changes to the system data log setup, use the 
System Data Logging Setup user rights listed 
below. 

Save System Log Setup System Data Logging Setup; Save Setup 
button 

allows system data logging setup selections to 
be saved and used for logging operations 

Start System Log System Data Logging Setup; Start Log 
button 

access to start system data log file 

Stop System Log System Data Logging Setup; Stop Log 
button 

access to stop system data  log file 

System Log Operator Message Users/System Operator Message access to add operator events to the system log file 

Access Security Setup/System Security access to all system security settings including 
users and user level rights 

Clear Error Log EZ-View Logger; Clear logger button allows EZ-View system logger entries to be cleared 

Save Error Log EZ-View Logger; Save Logger File button allows EZ-View system logger entries to be saved 
to a file 

Sim/Real Time Mode Mode/Simulation Mode – Real Time Mode allows selection of simulation mode where all data 
values are simulated by EZ-View software or real 
time mode in which all data is gathered from 
attached controllers. 

Create Custom Reports Audit Trail Viewer; Custom Audit Report 
button  

allows access to search function to build a report 
based on key search text entered 

Access Email Setup Setup/Email Client Settings provides access to all email settings and address 
entry  
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User Right Menu/Item Location Description 

Create Email Address Email Settings; Create Address button allows new email addresses to be added to the 
system 

Delete Email Address Email Settings – Email Addresses tab; 
Delete Address button 

allows existing email addresses in the system to be 
deleted 

Same Email Setup Email Settings; Close and Save button allows settings for the email server (log in name, 
password, etc.) to be saved. 

Access Web Server Setup Setup/Web Server Settings allows access to the web server settings screen 
 
Note:  If the user does not have access rights to 
this screen, they will be unable to view the 
computer’s IP address which is required for remote 
access.  To prevent a user from changing the 
enable/disable state of the web server, use the 
following setting below. 
 
 

Save Web Server Setup Web Server Settings; Done/Save button allows the web server enable/disable selection to 
be saved and used 

Access Relay Card Setup Setup/Relay Card Settings allows access to the relay card settings screen 

Save Relay Card Setup Relay Card Settings; Close and Save button allows the current selections for relay use to be 
saved and used 

Auto Tune Loop EZT-430i CM Detail view – Detail tab; Auto 
Tune button 

allows access to EZT-430i CM control loop tuning 
enable/disable 

Auto/Man Loop EZT-430i CM Detail view – Detail tab; 
Auto/Manual button 

allows access to EZT-430i CM control loop 
auto/manual output operation and setting manual 
output percentage  

Edit Soft Alarms Software Device Alarms access to change alarm setpoints, alarm message, 
alarm type, and activation 

Save Soft Alarms Software Device Alarms; Save Alarms 
button 

applies to saving the alarm settings to hard disk 
including setpoints, enable/disable and alarm 
message 

Print Soft Alarms Software Device Alarms; Print Alarms button allows the current alarm settings to be printed 

Export Soft Alarms Software Device Alarms; Export Alarms 
button 

allows a copy of the current alarm settings to be 
created in .csv format and saved to a different 
location 

Quit Application File/Exit access to stop the EZ-View application 
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6.2 Audit Trail Viewer 

The “Audit Trail Viewer” is accessed from the View menu.  It allows the user to view all activities performed 
during a particular day.  The date, time, user name, device and action are provided.  If security is enabled and 
the audit trail is turned on, the audit log is written to by the system during any operator event that changes a 
parameter in the control system.  Any actions that involve data files as well as the clearing or 
acknowledgment of alarms is also written to the audit trail.  Audit trail files are encrypted and read only.   
 

 
 
The toolbar at the top of the audit trail window provides the following functions (from left to right): 
 

 
 
 
NOTE: Audit trail logs are created and written to daily.  To activate the audit trail, the user must click on the 

"Enable Security" checkbox on the "Rights and Options" tab under the system security section of 
the program. 
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6.2.1 Custom Audit Reports 

The Custom Audit Report feature of the audit trail viewer, allows the user to search all audit trail files stored 
on the hard disk for a particular text string.  The text can be user name, particular device or even a date or 
time.  When the custom audit report is selected from the toolbar, the search window will be shown. 
 

 
 
Enter in the desired text string to search for and press the “OK” button to begin the search.  To close the 
search window, press the “Cancel” button.  Once the search is started, the audit trail viewer will be populated 
with entries found in each audit file that have a matching entry for the search string.  A progress bar will be 
shown at the top right of the audit trail viewer window to update the user on the search progress. 
 

 
 
Depending upon the search string and number of audit files present on the hard disk, the search could take 
an extended amount of time.  The search can be cancelled at any time by pressing the “Cancel Custom 
Report” button on the toolbar. 
 
NOTE: While the custom report is being created, the user can navigate to different view screens or perform 

other tasks.  The search will continue in the background and allow the user to come back and view 
the data at a later time. 
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7 Setup Options 

EZ-View provides several addition features that can be enabled through the Setup menu.  These include the 
software provided device alarms, optional relay card, email client and web server settings. 
 
 

7.1 Software Device Alarms 

EZ-View includes an alarm manager that allows the user to configure up to 200 individual “soft” alarms that 
can be tied to any point in the system.  This includes process values, setpoints and percentage of output for 
any device enabled in the system.  Each alarm can also be assigned a specific alarm message that will be 
shown in EZ-View’s alarm logger when the alarm is activated. 
 

 
 
To configure an alarm, select the alarm by clicking anywhere on the row for the alarm to be configured.  The 
current alarm values will be shown in the entry fields at the top of the window.  Select the desired point to be 
monitored by the alarm be selecting it from the “Tag Name” drop-down menu. 
 
The “Alarm Type” field is used to select the type of alarm.  Available options include “Low” and “High” 
process alarm types.  
 
The “Alarm Active” checkbox allows the alarm to be enabled and disabled without altering the alarm’s 
configuration.   This allows the user to individually enable and disable particular alarms based on certain 
operating conditions. 
 
NOTE: If an alarm is active, disabling the alarm will not allow the alarm to be cleared from the System 

Alarm log.  Once an alarm activates and is logged, the alarm condition must clear in order for the 
alarm to be cleared from the System Alarm Log. 
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The “Alarm Message” field allows the user to enter up to 25 characters to describe the alarm.  When the 
alarm activates, this message will be displayed with the alarm indication in the System Alarm Log. 
 
The “Alarm SP” and “Alarm DB” fields are used to enter the value at which the alarm activates and 
deactivates.  The alarm dead band (DB) can be entered as a positive number only, and is “safe-sided”.  For 
high alarm types, that requires the value being monitored by the alarm to drop below the alarm setpoint by 
value entered for the dead band in order for the alarm to clear.  For low alarm types, that requires the value 
being monitored by the alarm to rise above the alarm setpoint by the value entered for the dead band.   
 
The toolbar at the top of the window provides the following functions (from left to right): 
 

 
 
 
NOTE: Any changes to the alarm settings must be saved for them to take affect.  Closing the Software 

Device Alarms window prior to saving the alarms will cause any changes to be lost. 
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7.2 Relay Card Settings 

The optional relay card can be used to provide a local alarm output at the computer that can be used for 
audible and/or visual indication of an alarm to alert operators in the vicinity.  It can also be configured to use a 
relay output to operate an auto dialer. 
 

 
 
The Main Alarm Contact selections allow the user to choose which relay (K0 – K7) will be used for the alarm 
contact.  When a check is placed in the enable/disable checkbox to enable the relay contact, and an alarm 
occurs, the relay will be energized and its contacts will close.  The relay will stay energized until an operator 
silences the alarm by pressing the “Silence Beeper” button on the System Alarm Log screen. 
 
The Auto Dialer Alarm Contact selections allow the user to choose which relay (K0 – K7) will be used for 
the auto dialer control contact.  When a check is placed in the enable/disable checkbox to enable the relay 
contact, and an alarm occurs, the relay will be energized and its contacts will close.  The relay will stay 
energized for the time period entered in the “Reset Auto Dialer Contact After…Seconds” field.  The time 
period is dependant upon the auto dialer used, and must be set to the proper length of time in order to allow 
the auto dialer to complete the call. 
 
Once the relay is energized on the first alarm, if other alarms occur during the “on” time period, they will be 
ignored, and the auto dialer will complete its call(s) based on the first alarm.  Once the timeout period expires 
and the relay turns off, the system will be ready to initiate the auto dialer again on the next alarm.  
 
NOTE: Use of System Standby:  If the Windows operating system puts the computer into “Suspend” mode, 

all USB hubs are issued a reset when the suspend mode is executed.  This will cause the relay card 
to lose power briefly, resulting in all relays being reset even if an alarm is present.  Since the 
computer running EZ-View is a supervisory control and data acquisition system, it is recommended 
that power options for the computer under the Windows control panel, be set to “always on” and 
ensure “system standby” is set to never. 

 
 
7.2.1 Relay Card Installation 

The Ontrak ADU208 relay card is a USB interface device and can be plugged in to any available USB port on 
the computer.  Power for the operation of the card is provided through the USB connection.  There are 8 type 
“A” relay contact outputs in the ADU208 rated at 5A@120VAC or 5A@30VDC. 
 
The ADU208 also provides connections for 8 digital inputs; however, they do not provide any functionality in 
EZ-View.  The figure below show the proper connection of DC and AC loads. 
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WARNING: It is the responsibility of the end user to properly install and wire the relay outputs of the ADU208 

relay card according to all applicable electrical codes.  The use of 120Vac power poses a shock 
hazard due to exposed relay terminals.  It is recommended that a Class 2, 24V power supply be 
used to power indicator lamps, audible alarms, etc., as required. 
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7.3 Email Client Settings 

EZ-View’s email client provides the ability to send alarm messages to email and SMS addresses.  Up to 30 
addresses can be programmed into the system.  Each one can be configured to receive emails, SMS text 
messages or both.  Whenever an alarm occurs, EZ-View will send an alert to the specified address for each 
user in the list.  The email will contain the date/time of the alarm, the device name and the description of the 
actual alarm condition just as it is viewed in EZ-View’s alarm log. 
 
 
7.3.1 Email Address Entry 

Select the “Address Entry” tab in the Email Settings window to add new addresses to the system.  For each 
entry, enter the Full Name, Email Address and/or SMS Address (up to 50 characters each).  Then check the 
Email Alarms and/or SMS Alarms check box(s) to specify which address(s) the alarm messages are to be 
sent to.  Once all entries have been made, press the “Create Address” button to add the user to the list. 
 

 
 
NOTE: The SMS address is specific to the service provider.  Each service provider has their own unique 

address; however, the phone number is always the “name” for the SMS address entry.  Below are 
common examples for some of the more common cell phone providers.  There are internet sites with 
this information that cover most of the providers, or when in doubt, contact your service provider for 
the proper address format. 

 

Cell Phone Provider Maximum message length 
SMS Address to use (where 0123456789 is an 
example for a 10 digit cell phone number) 

Cingular 150 characters 0123456789@mobile.mycingular.com 

Cingular (GSM)   0123456789@cingularme.com 

Cingular (TDMA)   0123456789@mmode.com 

Nextel (now part of Sprint Nextel) 140 characters 0123456789@messaging.nextel.com 

Sprint PCS (now Sprint Nextel) 160 characters 0123456789@messaging.sprintpcs.com 

T-Mobile 140 characters 0123456789@tmomail.net 

Verizon 160 characters 0123456789@vtext.com 

Verizon PCS   0123456789@myvzw.com 

 

http://www.hurt911.org/investigation/sms-text-message-address.html
http://www.hurt911.org/investigation/sms-text-message-address.html
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7.3.2 Email Addresses 

Selecting the “Email Addresses”’ tab allows the user to view the list of addresses entered in to EZ-View.  By 
using the scroll bar at the bottom of the list box, you can view the name, addresses, and notification 
selections for each user.  To delete a user, click on the name of the user in the list box you wish to delete and 
press the “Delete” button.  Note that this will permanently remove the user from the list. 
 

 
 
 
7.3.3 Email Settings 

The “Email Settings” tab provides access to the email server configuration, which is how EZ-View is able to 
connect and send email messages over the computers network connection. 
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The Login Name is the name required for EZ-View to log into your company’s mail server.  You can use your 
login if one is not set up specifically for EZ-View on your network.  Contact your network administrator for 
assistance. 
 
The Return Address is the address given for EZ-View on your company’s mail server.  EZ-View does not 
accept email messages; however, this field is required for proper email delivery for security/anti-spam 
purposes.  If using your personal login name, you can also use your personal email address if one is not set 
up specifically for EZ-View on your network.  Contact your network administrator for assistance. 
 
The Password field is used for entering a password, if required by your network server, to send email.  
Contact your system administrator for assistance. 
 
This SMTP Server field is for entering the address of the email server used for sending emails.  This must be 
a valid mail server for which the above settings allow EZ-View access.  Contact your system administrator for 
assistance. 
 
This Email Subject field is used to enter a subject line for emails and/or SMS text messages.  It can be used 
to provide an identifier to the recipients of the alarm message to know that the message is from EZ-View for 
example. 
 
NOTE: It is recommended to put some form of entry in this field.  It can be left blank; however, many 

firewalls and spam filters will filter out messages without subject lines.  That may prevent recipients 
from receiving the email. 

 
Once all settings have been made, be sure to press the “Close and Save” or all changes will be lost and EZ-
View will continue to use the previous settings. 
 
 

7.4 Web Server Settings 

EZ-View’s web server allows users to view device operations remotely over an internet connection.  The web 
server provides “read only” access which means users can only view the operation of each individual 
controller connected to the system; set point changes, starting/stopping of profiles, etc., is not permitted.    
 

 
 
IMPORTANT: Windows Internet Information Services (IIS) must be installed and configured properly for 

web server operation.  Contact your network administrator for assistance. 
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The “Local Machine IP Address” is the IP address of the computer running EZ-View.  This IP address must 
be used to access the web server from the remote computer.  If the computer running EZ-View is on a 
network using DHCP, which assigns the IP address to the computer, the IP address could change and 
prevent users from accessing the web server if they do not have access to the new IP address.  It is 
recommended that the IP address of the host PC running EZ-View be set to a fixed IP address in order to 
prevent this from happening if the web server is going to be used.  Contact your network administrator for 
assistance in setting a fixed IP address.   
 
The “Current Web Folder Directory” assigns the location for EZ-View to publish the web page data for the 
controllers when the web server is enabled.  This directory must be set prior to enabling the web server.  
Clicking on the “Browse” button opens up a folder search window and allows the user to search and select 
the desired directory for EZ-View to use.  
 
Note that the selected location must be properly configured in Windows Internet Information Services (IIS) on 
the host PC running EZ-View.  Windows IIS is the web hosting service of the operating system and allows 
remote computers access to the web pages served by EZ-View.  If IIS is not installed or properly configured 
on the PC, the web pages will not be accessible from remote computers.  Contact your network administrator 
for assistance with the installation and/or configuration of Windows IIS. 
 
When the “Web Server Enable/Disable” checkbox is checked, the web server will be enabled and allow the 
viewing of system data remotely.  If the data is to be kept secure and is for local viewing only, removing the 
check from the checkbox will disable the web server and prevent users from remotely viewing the data. 
 
 
7.4.1 Viewing Web Pages Remotely 

Once Windows IIS is properly configured and the web server is enabled, the individual web pages for each 
controller can be accessed.  The web pages are named “device0.html” through “device127.html” which 
correspond to devices 1 through 128 in the Device Setup screen. 
 
To view a controller’s web page, enter the following link in the remote PC’s browser address window:  
http://”IPaddress”/”web page name”.  For example, to view the first device’s web page (device0.html) using 
the example address above, enter http://192.168.3.8/device0.html.  The following example (see next page) is 
typical of the device web page appearance.  The web pages automatically update every 15 seconds and 
provide information on each individual loop, profile status, alarm status and digital input and output status for 
the controller. 
 
NOTE: Once the web server is enabled, all device web pages are available regardless of the enabled 

status of the controller.  If the user accesses a web page for an inactive controller, there will be no 
status information available and the controller will be listed as inactive. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://”ipaddress”/”web%20page%20name”
http://192.168.3.8/device0.html
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Device Web Page Example: 
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8 Troubleshooting 

Many of the settings in EZ-View are fixed to make system setup easier.  If it is not communicating with a 
controller attached to the system, try the following suggestions to get it going. 
 
First, the communications baud rate is fixed and cannot be adjusted.  This was done to insure that the 
optimum communications rate is used for a balance between speed and noise immunity in industrial 
environments.  If the communication lines are run properly and follow the guidelines in type of wire and 
distance for an RS485 network, this should not be a problem. 
 
However, if the communications are taking place over an Ethernet network using the PC-E protocol converter 
and Moxa, MGate Modbus master, the communication rates of the serial ports on both devices must be set to 
match EZ-View, i.e., 9600 baud, 8 data bits, 1 stop bit, even parity.  
 
Second, EZ-View is set to use communications port one on the host PC.  If a machine is to be used for data 
acquisition to track data for products runs, the data acquisition portion of the machine is usually more 
important than other operations that the machine is used for (word processing, reports, etc.).  Most of the time 
corporations will dedicate a machine for the data acquisition process since the data from the process runs are 
very important to the manufacturing or research process.  Almost all computers have at least one serial port 
on them.  This first port is usually set for comm1.  Devices like modems can be moved to a second serial port 
or add-in card. 
 
Third, make sure that all controls enabled in EZ-View have a corresponding real world device set for the 
corresponding Modbus address.  If a controller is enabled in EZ-View, but there is no controller set for that 
address, communications will continually fail for that device. 
 


